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About this Practice Workbook . . . . . 
 

• Module 15 – Earthwork.zip will be provided for download. 

• Extract the zip file to the root C:\ 

• All files are then automatically extracted here: 
                     C:\NCDOT Training\Roadway\Module 15 - Earthwork 

• With these subfolders: 
 

 
The Module 15 Earthwork PDF will also be located here 
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• This PDF file includes bookmarks providing an overview of the document. Click on the 
bookmark to quickly jump to any section in the file. You may have to turn on the 
bookmark function in your PDF viewer, such as Adobe Reader. 
 

• The dataset used throughout this module uses English units and US Survey Feet. 
 

• Each Module in this series is self-contained. You can jump to any section and begin the 
exercises. 
 

• The WorkSpaceSetup CFG should be set to the following variables: 
o NCDOT_USE_LOCAL_WORKSETS = L2 
o NCDOT_UNIT_TRAINING_WORKSETS = Roadway 

 

• This training module uses the DOT-US North Carolina WorkSpace, R-2635C (Training) 
WorkSet and NCDOT_Roadway Role. It is very important that you select the correct 
WorkSpace, WorkSet and Role. 
 

• NCLUG / NCDOT Bentley ORD Open X presentations from each NCDOT Department: 

https://www.nclug.com/ 

 

• This workbook was written with the release of OpenRoads Designer 2023 

OpenRoads Designer Readme (bentley.com) 

OpenRoads Designer 2023 Introduction - YouTube 

 

  

https://www.nclug.com/
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20Readme-v14/en/GUID-43563D21-2E4C-4133-AB04-26E6A4F630EB.html
https://www.youtube.com/playlist?list=PLnJUnxLwu_N64Qu3p0eIiocIUX2U63zVA
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Overview 
 
OpenRoads Designer (ORD) provides new methods for Earthwork Calculations and 
documentation that will replace the methods used by Geopak. Prismoidal Volumes are now 
reported by the program and offer a true surface to surface comparison. These volumes will 
replace the Average End Area method that was utilized with Geopak.  
 
This module will focus on the process of creating the earthwork volumes. This is a 
straightforward process and should be relatively easy to complete. One of the most important 
concepts to understand and remember is that this will be a surface-to-surface comparison. That 
means that the Earthwork Volume will only be as good as the Proposed Model. Errors and 
omissions in the Proposed Model will be carried to the Earthwork Volume calculation and 
because this process does not involve Average End Areas the only way to eliminate these errors 
is to produce a Proposed Model that accurately reflects the roadway design. 
 
This training module does not include any modeling instruction or guidance. The example files 
in this module include very simple models. This is intentional as the focus of this training 
module is the steps to compute and report the earthwork volumes. NCDOT has provided 
additional training modules that give guidance for producing proposed models. This guidance 
should be followed, and the final model should represent as close as possible the final roadway 
design.  
 
When creating and verifying the earthwork volumes the design and engineer must also verify 
the proposed roadway model. The necessity to start with a detailed and accurate model cannot 
be overstated. 
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Introduction 
 
Earthwork Calculation completed with OpenRoads Designer will introduce some new terms and 
concepts. This introduction will give an overview of the new OpenRoads workflow and contrast 
that with the methods used with Geopak. 
 

The Old Way – Average End Area 
 
Geopak used the Average End Area method to calculate Earthwork Volumes. This involved 
measuring the cut and fill areas on two consecutive cross sections, finding the average of those 
areas, and multiplying the average by the distance between the cross sections. This is shown in 
the two screen shots below with the familiar blue shape representing fill and the white shape 
representing cut. 
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The New Way – Prismoidal Volumes 
 
OpenRoads Designer uses Prismoidal Calculations to determine the earthwork volume. 
Prismoidal Volume Calculations use a more complicated formula that uses the area of two 
bounding surfaces and the area midway between these surfaces. In roadway modeling the 
bounding areas are the triangulated surfaces of the Existing Terrain and Proposed Model and 
the midway area is calculated based on the tapering sides between the bounding triangular 
surfaces. This results in a true surface to surface comparison. This in turn results in an 
improvement in accuracy compared to the Average End Area. The main limitation being the 
accuracy of the proposed model. The image below shows the cut volumes in green and the fill 
volumes in red. 
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Contrast and Compare – Average End Area vs Prismoidal 
 
Prismoidal Volume Calculations will produce a more accurate earthwork volume than Average 
End Area. Average End Area volumes are reliant on the Average Area of two consecutive cross 
sections being representative of the design in that section. Some of the things that can affect 
the accuracy of the Average Areas are: 

• Is there a ridge or channel in between the sections that does not show up on either 
section? 

• The cross-section interval density. 

• Do the cross sections include the beginning and ending of: 
o Tapers? 
o Alignments? 
o Bridges? 
o Culverts? 
o Horizontal and Vertical Curves? 

• How are intersections and other non-typical areas represented in the cross-sections. 

• How are break points and shear lines incorporated into the cross-sections. 

• Has the cross-section been skewed relative to a baseline? 
 
Some of the benefits of using the Prismoidal Volume Calculation method include: 

• It includes any deviations in the existing terrain that are not included on the cross-
sections. 

• The model is based on drop interval of 5’ set by NCDOT, this is a 10x improvement on 
the standard 50’ cross section interval. 

• Automatically includes tapers, transitions, Begin / End points, key points in the 
horizontal and vertical geometry. 

• Non-typical areas included. 

• Break points and shear lines are not required or used. 

• Not dependent on Cross Section orientation. 
 
Assuming that the existing ground is accurate the most significant issue that can affect the 
accuracy of a Prismoidal Volume Calculation is: 

• The accuracy of the proposed model. The proposed model must accurately represent 
the design. 

 
It is critical to review NCDOT guidance on modeling and standards for producing a proposed 
roadway model. 
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Prismoidal Volume Calculations are based on the area of each triangle included in the existing 
terrain model, so they will automatically include all the features; channels, ridge lines, etc. that 
are in the existing terrain model. Features that would not be included in average end area 
calculations. 
 
The interval density for earthwork has been set to 5’ as a standard by NCDOT, this will provide a 
high level of accuracy. The proposed surface will have 10x the accuracy of a standard 50’ cross 
sections interval. In conjunction with 3D volumes this improves the accuracy of the earthwork 
volume calculation. 
 
Tapers, transitions, begin/end construction, begin/end bridge stations, horizontal and vertical 
control points are all included in the model when using the standard NCDOT modeling 
guidelines and principles. These are features that are not necessarily included in the Average 
End Area calculation method. 
 
Non-typical areas such as intersections, roundabouts, driveways, grade to drain, bridge 
abutments etc., are all included when following NCDOT modeling guidelines. These will be 
modeled as 3D components that will not be affected by a cross-section layout and will be 
included in the earthwork calculations. 
 
Shear Points and Break Lines are no longer required for Earthwork because earthwork is no 
longer dependent on the cross-section layout. Y Lines are modeled to the Edge of Travel on L 
lines. The Prismoidal Volume calculation will include the volume up to the edge of pavement. 
Cross-Sections are not required to match up in a specific way to generate an accurate 
Earthwork volume. 
 
Cross sections that shear across areas that are not parallel to the centerline; lane tapers, U-Turn 
bulbs, intersection corners, gore areas, etc. produce end areas that do not accurately reflect 
the actual volumes. Using Prismoidal Volumes these areas will be accurately calculated if the 
proposed model is accurate. 
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Model Overview 
These are a few of the general modeling guidelines that will help produce accurate earthwork 
volumes. Each project is different, and it is up to the designer to ensure that the model has 
been developed in a way that accurately reflects the design. The model should be continually 
refined and become more detailed throughout the design process.  
 
The Prismoidal Volumes will only be as good as the proposed roadway model. 
 

Proposed Corridor Setup 
 
The designer should consider the CMD file setup. Named boundaries can be utilized to separate 
earthwork volumes, but creating named boundary groups in a file that contains all the corridors 
may not be feasible. Creating a separate file for each alignment/corridor will be the easiest 
when only considering the earthwork calculation. If the designer wants to include more than 
one alignment/corridor in a single CMD file, they should consider how that will impact 
earthwork calculations. 
 
This file contains a single Corridor for Y8 in the R-2635C example file. When computing the 
earthwork only the corridor in this file will be considered. 
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If all the corridors are in a single file then the user will have to spend a significant amount of 
time placing and adjusting named boundaries to separate the earthwork for each alignment. 

 
Including these two corridors in a single file would not result in a significant amount of effort 
because it would be relatively simple to place two named boundaries around each corridor, 
since they do not overlap or intersect. 

 
It is easier to make the decisions when setting up the CMD files than it is later in the project 
when trying to compute earthwork volumes. 
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Intersections and Non-Typical Areas 
 
Prismoidal volumes do not rely on cross section areas that match perfectly through 
intersections or other non-typical areas. Prismoidal volumes do not require Shear Points or 
Break Lines. Models for non-typical areas should follow NCDOT guidance. 
 

This is an intersection that has been modeled with a combination of design templates, linear 

templates and surface templates. 

 

The red volumes show that even though this is a combination of modeling techniques the 

earthwork volumes will be computed correctly and shear exactly with the EOT on the through 

roadway. 
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Tapers and Transitions 
 
Pavement and shoulder tapers should be accurately modeled, this includes the use of 

parametric constraints, point controls, corridor references and key stations. Even if these areas 

do not show up on cross-sections, they will be included in the Prismoidal Volume 

This area shows a turn lane taper that has been added and the right turn lane shearing at an 

intersection. 
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When the earthwork volumes are computed they match perfectly with the taper and the shear 

lines. If this had been done using average end area methods, then it would have required 

multiple extra cross sections to capture this area accurately. Additionally, if the design had 

changed then new cross sections would be required at the new taper points. In this case since 

the model is the design, any changes will be included in a new earthwork calculation. 
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Earthwork Calculation DGN File 
 
Earthwork calculations will be done in separate DGN files. Intersecting roadways will need 
separate corridors to keep the earthwork calculation separate. Named boundaries can be used 
to separate Y lines that do not intersect but the user may still find it easier to create a separate 
earthwork file for each corridor. These concepts will become clearer when completing the more 
complex exercises. 
 
The general workflow for computing earthwork volumes: 
 

• Create a file using the NCDOT 2D Seed File 
 

• File Naming Convention 
o TIP#_RDY_EAR_Alignment 
o R-2635C_RDY_EAR_Y8.dgn 

 

• Folder location 
o R-2635C\Roadway\Design 

 

• Reference files required 
o Existing Terrain Model 

▪ Set Active to get Default 3D Model 
o Alignment file 

▪ Required for advanced earthwork calculations using named boundaries. 
o Proposed Corridor CMD file or files 

▪ This should include all proposed models needed for the desired 
earthwork calculation. 

• Proposed Roadway 

• Proposed Special Ditches 

• Non-Typical Areas 
 

• Create Cut and Fill Volumes 
 

• Placed Named Boundaries as required 
 

• Report Earthwork Volumes 
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Exercise 1 – Simple Earthwork Calculation 
 

In this exercise we will create and report on the Earthwork Volume for an entire project 
without breaking it up as required for an Earthwork Balance Card. This process could be 
utilized at the functional or DRPS stage or during design when trying to balance the cut 
and fill volume. 
 
Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 

 
 
 
The WorkSpace is DOT-US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Create Earthwork Volumes 
A. Create a new DGN file for the Earthwork Calculation 

• Filename 
1. R-2635C_RDY_EAR_ALL.dgn 

• Folder Location 
1. …\R-2635C\Roadway\Design 

• Seed File 
1. Seed2D – English Design.dgn 

B. Attach the required reference files: 

• Existing Terrain Model 
1. R-2635C\Final Survey\R-2635C_NCDOT_FS.dgn 
2. Attach the Existing Terrain Model in the FS file 

 
3. When attaching Terrains and Models for use in Earthwork Calculations Live 

Nesting should be OFF. Live Nesting can result in the program reading 
multiple surfaces when computing the Earthwork resulting in errors. 

 
4. Set the Existing Terrain Active to Create the Default 3D Model 
5. The 3D model is required to calculate the earthwork 
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• Proposed CMD Files, this exercise will calculate the total project earthwork 
volume  
1. R-2635C_RDY_CMD_Y8 
2. R-2635C_RDY_CMD_Y18 
3. R-2635C_RDY_CMD_RPY18A 
4. R-2635C_RDY_CMD_RPY18B 

• Note that for this calculation the alignments are not required because there are 
no Named Boundaries. 

 

• Live Nesting should be OFF for all Files. 
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A. Open a view with the Default 3D Model shown. The Default 3D View must be open 
in order to run the Earthwork Tools. 
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C. Create the 3D Earthwork Volumes 

• Use the OpenRoads Modeling workflow.  

• On the home Tab find the Model Analysis and Reporting Section. 

 

• Under Civil Analysis Find the Create Cut and Fill Volumes Tool. 
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• Note that this same tool is available under the Terrain Tab in the Analysis Section 
under Volumes 
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• The dialog Box should be set correctly by Default 
1. Cut Feature Definition = Volumes_Cut 
2. Fill Feature Definition = Volumes_Fill 
3. Compute Unsuitable = Unchecked 
4. Compute Custom = Unchecked 

a. Custom volumes will be used for DDE Calculations and Detour Removal 
calculations in subsequent examples 

5. Compute Substrata = Unchecked 
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• Left Click for each pop-up window to accept these settings. Left click in any view 
to start the Earthwork Calculation, the 3D view must be open. 
 

 

• A processing window should appear. 

 
 

• The Earthwork Volumes will be shown as new triangulated volumes in the 3D 
view, red will be the fill volume and green will be the cut volume. These are 3D 
Mesh Volumes.  
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• The Cut and Fill Volumes were determined automatically by the program. Each 
component of a template is assigned a volume option based on the Feature 
Definition. For example, in the roadway templates fill slopes are assigned a 
feature definition of TC_Grass Side Slope-Fill and this feature definition is 
assigned a volume option of design. Any feature definition that has a volume 
option set to design will be included in the cut and fill volume calculations. The 
program can automatically determine which elements represent the top surface 
and which elements represent the bottom surface out of all the elements that 
are assigned to a volume option of design. 
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• Bridge components such as the bridge deck are assigned a volume option of 
none. This means that when the program is determining how to calculate the 
earthwork cut and fill volumes the bridge deck components in the model will be 

ignored. 
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2. Review Volumes for Accuracy - Visually 
A. The first step after completing the volumes is to visually review the shapes for 

Accuracy, this file and these shapes will be part of the required submittal for 
Earthwork Documentation.  

B. To make the review easier setup the 3D Model as Follows. 

• Set the Existing Terrain Override Template to Yes and Triangles 
 

 

• Turn off the proposed Corridor References. 
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• Set the Display Style to Illustration Modeling. 
1. To do this Look for the View Attribute Icon in the Top Left Corner of the View 

Window 

 
2. At the top of the Dropdown Menu find the Display Style 
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3. This Dropdown Menu contains numerous setting for different display styles, 
one of the styles that is useful when using 3D views is Illustration modeling. 
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C. In the 3D view, Zoom, Turn and Pan around the DGN to visually verify there are no 
areas of concern, this would be indicated by the Red or Green Volumes that are 
obviously not in line with the proposed design. Visually verifying the shapes is one of 
the easiest and most reliable methods to verify the accuracy of the earthwork. 
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D. This view shows how the earthwork has been ignored in an area of overlay and 
wedging. Reviewing the 3D view and the volume shapes makes it easy to see how 
the volumes have been calculated correctly. 
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D. For these exercises the bridge abutments have been left out and it is very easy to 
see that these sections are missing from the earthwork calculations. If these 
abutments were included in the model they would be included in the earthwork 
calculation. 
 

 
E. At this stage any obvious issues will have to be addressed by revising the proposed 

model. The Cut and Fill Volume shapes cannot be modified, so any errors need to be 
corrected in the proposed CMD files and then the Earthwork Shapes will need to be 
recalculated. The user will be given the option to delete any previous earthwork 
volumes during subsequent runs. 
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F. Note : Older workspace versions and custom templates may experience 
the following issue with Pavement Wedging areas where earthwork 
will be computed over the existing pavement. The following is a 
discussion of the issue and a description of the solution. 
 
Here we can see an example of a minor discrepancy in the earthwork volumes. In 
this view we can see where the wedging ends and the full depth pavement begins. 
This is evident by the ramp up on the outside of the existing pavement shown in red 
and the numerous red and green areas shown on top of the existing pavement. 
Although every section and template drop models the wedging depth to perfectly 
match the existing ground line the Prismoidal Volume uses each existing triangle and 
each proposed triangle to calculate a volume. Those triangles do not line up exactly 
with the sections or exactly with each other. That is going to cause these 
irregularities in the volumes displayed. These are very small volumes and may or 
may not be considered incidental, but this is an example of how easy it is to visually 
identify these areas and make a determination on the magnitude of the error and 
what if anything needs to be done about it. 
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G. This issue with wedging areas needs to be corrected at the template level. 
1. Depending on the workspace version or how the custom templates were put 

together the wedging component feature definitions may be set to a volume 
option of DESIGN. This means these components will be used when creating 
the earthwork volumes.  

2. This needs to be revised and set to ta volume option of NONE. When the 
feature definition is set to a volume option of NONE these components will 
be ignored when creating the earthwork volumes. 

3. To set the Feature Definition to none open the corresponding CMD file, in 
this case R-2635C_RDY_CMD_Y8 

4. In the OpenRoads Explorer Dialog find the OpenRoads Standards Section. 
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5. Click on the Current Design File → Feature Definitions → Mesh  
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6. Under the Roadway Asphalt Section find the Feature Definition for the 
TC_Asphalt Base Course Wedge. Note that this matches the template 
component feature definition that is resulting in the error and the actual 
feature definition in any custom template may be different. 
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7. In the Properties Dialog find the Mesh section. 

 
 

8. In this section the Volume Option is shown as Design 
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9. Click in the Volume Option box to activate a drop-down list and change this 
selection to None. 

 
 

10. Repeat this process for the Intermediate Course Wedge and Surface Course 
Wedge.  

11. Depending on how the template is assembled this may also need to be 
completed for the Surface Course. 

12. If there is one large component that is full depth and minimum resurfacing 
over wedging. This needs to be split into multiple components or the 
minimum 1 ½” layer over wedging needs to be removed and surface shown 
as a single component 

13. Alternately all pavement layers could be set to none since there is a subgrade 
line that would control the earthwork volumes 

  



 

Module 15 – Earthwork 
 

 
 

Page | 38  
 
 

14. The images below show an example of how this template was modified. The 
Left Side has been revised  and the Right Side was not.  
 

 
The earthwork is no longer computer under left side wedging. 
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THIS ENDS THE SECTION ON REVISING FEATURE 
DEFINITIONS TO ELIMINATE EARTHWORK VOLUME 

ERRORS 
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3. Review Volumes for Accuracy – Dynamic Sections 
A. After any revisions are made and the proposed shapes look acceptable a more 

detailed review can be done with the Dynamic Cross Section View. 
B. In the 3D Model  

• Set the View Display back to wire frame 

• Turn the Proposed Corridor reference files back on. 
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C. Switch Back to the Default 2D Model and open an additional window. 
 

 
D. Go to the Corridors Tab of the OpenRoads Modeling workflow and the Review 

Section. 

 
 

E. Select the Dynamic Sections tool. 
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F. Select the Y8 Corridor and click in the open view. Notice the red and green shapes, 
these are the cut and fill volumes from the Default 3D model. 

 
 

G. Under View Properties in the Cross Section View, check on Display Cut and Fill 
Graphics and Display Cut and Fill Values. 
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H. Now the Cut and Fill Areas will be shaded and the Cut and Fill Area at the section 
and the volume will be shown below. This is another visual check that should be 
performed to ensure that the Cut and Fill Volumes from the Default 3D model do 
match the proposed design. 

 
 
Note that this method will only display the Graphics and Area for the selected 
corridor, it will not show them for adjacent corridor and linear templates. The areas 
will be visible but not shaded and the volumes will not display. The volumes and 
areas in this view are meant as a check of the accuracy of the model. 
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4. Report Earthwork Volumes 
A. After the earthwork shapes have been reviewed for accuracies and any errors in the 

proposed model have been corrected the volumes can be reported out of the 
program. 

B. The simplest way to get the volumes is to measure directly from the Default 3D 
Model. Open the Default 3D model and turn off all the references. 

 
C. Under the Open Road Modeling Workflow switch to the drawing Tab and find the 

measure section. 
 

 
D. Select the Measure Volume tool. 
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E. Clicking either the Cut or Fill Area will measure the volume of the Prismoidal Shape. 
The measure will include all the Cut or Fill volume, even volumes that are not 
connected, so in this example it will be the total Fill or Total Cut volume for the 
project. 

 
F. Alternately use the Element Selection tool and pick the Cut or Fill Volume. The 

Volume will be reported in the properties dialog box.  

 
 

G. The units in both these cases are Cubic Feet. 
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H. Caution when using the Component Quantities report located under 
the Corridor Reports section or the Model Analysis and Reporting tool 
group. 

 
 
This tool utilizes the Average End Area method to determine the volume and surface 
area of components from the template drops. The volume reported when using 
component quantities will not match the Prismoidal volume that is measured 
directly from the volume of the 3D shape 
 
Component Quantities also will only work on a single corridor, it will not provide the 
total if multiple corridors, linear templates or surface templates are used. 
 

I. This process will provide a quick and simple Earthwork Volume Calculation that is 
most appropriate for conceptual design iterations and preliminary plans. More 
detailed Earthwork Calculations will be required for more advanced design 
submittals. The following exercises will detail the setup required for more detailed 
earthwork runs but the general process will be the same. 
 
The final section in this module contains guidance on the submittal requirements to 
NCDOT. 

  



 

Module 15 – Earthwork 
 

 
 

Page | 47  
 
 

Exercise 2 – Earthwork Using Named Boundaries 
 
This exercise will provide an example of a more detailed Earthwork Calculation. This Calculation 
will be completed based on NCDOT guidance and requirements for completing the Earthwork 
Balance Card. This is the process that would be used later in the design process when the 
modeling is complete. Detailed areas have been modeled along with any special ditches and 
grade to drain areas.  The process will generally follow the same steps as a simple calculation 
detailed in the previous section, with the main difference being the inclusion of named 
boundaries as a way to break out the Earthwork Volumes into sections that meet NCDOT 
requirements. 
 
The NCDOT Requirements for Earthwork Balance Sheets will be listed in the Roadway Design 
Manual. Always refer to the Manual for the latest version, the requirements below are based 
on the May 2024 version and are in Section 15.4.1.1.  
Quantity Breakdowns are required as follows: 
 

• Summary points every 3,000 feet. 

• Summary Points Begin / End at Each Bridge 

• Summary Points Begin / End at Major Intersections 

• Summary Points Begin / End at At-Grade Railroad Crossings 

• Separate volumes for each alignment 

• If required for widening projects: Summaries for Left and Right 

• If required for complex projects: Phased with traffic control plan 
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Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 
 

 
 
The WorkSpace is DOT_US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Create Earthwork Volumes 
A. Create a new DGN file for the Earthwork Calculation. For this exercise we will use 

Y18 as the example, this alignment has a structure over Y8 and requires a break in 
the earthwork. 

• Filename 
1. R-2635C_RDY_EAR_Y18.dgn 

• Folder Location 
1. …\R-2635C\Roadway\Design 

• Seed File 
1. Seed2D – English Design.dgn 

B. Attach the required reference files: 

• Existing Terrain Model – R-2635C_NCDOT_FS 
1. Attach the Existing Terrain Model within the FS file 

 
2. Live Nesting should be OFF. 

 
3. Set Active to Create the Default 3D Model 
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• Proposed Alignment for the reference corridor 
1. This is required for placing the named boundaries 
2. This is in the Alignment folder under Roadway 

 

 
 

• Proposed CMD File, this exercise will calculate the earthwork volume total for a 
single Corridor. For more complicated designs include the proposed roadway, 
any hydraulic models that need to be included, any grade to drain areas or other 
special areas such as drives or small intersections that will not have a separate 
line item in the earthwork balance card.  
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C. Create the 3D Earthwork Volumes 

• Create the Cut and Fill Volumes in the Default 3D Model. This is the exact same 
process used in the previous example 

• One View must be open with the Default 3D model. 

• Using the OpenRoads Modeling workflow, navigate to the Home Tab and find 
the Civil Analysis section of the Model Analysis and Reporting tool Group. The 
drop down has the toll for Create Cut Fill Volumes. 
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• Set the dialog box with optional computations unchecked. 

 

• Left click to accept selections and create the earthwork volumes. There will be 
Gap at the structures because the Feature Definition for the components in the 
bridge template is set to a Volume Option of None. This tells the program to 
ignore these components when computing earthwork. There are also gaps at 
intersections with the ramp models. With ORD we model the through roadway 
to the edge of travel and the intersection roadway will be modeled to match the 
through roadway edge of travel. (Review guidance on detailed modeling for 
more information on intersection) This is the reason that shear points are no 
longer a necessity when computing earthwork. 
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• The volume Option can be seen in the Properties Dialog when selecting the 
properties for a mesh feature definition. By finding the TC_Bridge Deck Feature 
Definition in the Open Roads Explorer Dialog 

And reviewing the Properties, we see the Volume Option is set to None. 
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• This process has been the same as the steps required for the simple earthwork 
calculation. At this point use the various review techniques to verify the 
earthwork volumes are correct. Using the properties dialog or the Measure 
Volume Tool can directly measure the 3D volumes in the Default 3D Model. 
 
CUT = 10,089.29 CY  
 
 
 
 
 
 
 
 
 
 
FILL = 90,211.34 CY 
 
 
 
 
 
Note that the measure volume tool 
reports the volume in cubic feet not 
cubic yards and it must be 
converted. 
 

• For reporting the quantities in the earthwork balance card, we will need to split 
the earthwork into two sections because there is a requirement to break the 
earthwork for structures. Named Boundaries are required to get the earthwork 
volumes based the balance card guidelines. The boundary layout will be based 
on the specific project and should be done according to the NCDOT guidelines 
and requirements. 
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2. Place Named Boundaries 
A. Named Boundaries are required to separate the earthwork. 
B. The alignment reference file should be ON in the Default model. 
C. Switch to the Drawing Production Tab in the OpenRoads Modeling workflow. 

 
 

D. Select the named boundary tool. 

 
 

• Select Civil Plan 
1. This could also be done with the 2 points or polygon method. 
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• Set the dialog box as noted 
1. Drawing Seed – None 
2. Detail Scale – Full Size (This is not critical) 
3. Name – EW 

a. For this example we only have 1 Named Boundary Group and this is not 
critical, the report will show the end station for each boundary 

4. Group - New 
5. Name –Y18  

a. For this example we only have 1 Named Boundary Group and this is not 
critical 

6. Length – 1800’ (for this 
example) 
a. For a long run with 

no structures or 
other breaks this 
could be set to 
3000’ 

b. For this example, 
1800’ places the 
boundaries in 
approximately the 
middle of the bridge 

c. This length will be 
determined by the 
designer to place 
the break in the 
correct location 

7. Left / Right Offset – 
500’ 
a. This needs to be 

large enough to 
contain the model 
limits 

8. Overlap – 0 
9. Boundary Chords – 10 

a. This can be adjusted as necessary to contain the model. 
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• Place the named boundaries 
1. Left click to identify the Y8 alignment as the Path Element 
2. Left click to identify the start station at 10+00.00 
3. Left click to accept the boundary length of 1800’ 
4. Left click through the remaining selections to finish the placement of 2 

boundaries. The split between the two should be on the structure. 
5. This view is rotated so that Y18 is Horizontal. 

 

 
Note that the named boundaries do not have to start and stop at the Begin / 
End Bridge stations. Because the Bridge is set to a Volume option of None 
the earthwork volumes will automatically start and stop at the Begin and End 
stations.  
 
The named boundaries just need to meet somewhere in between the Begin 
and End bridge. 
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3. Report Earthwork Volumes 
A. Go back to the Home Tab and the Model Analysis and Reporting Tool Group. Under 

the Civil Analysis dropdown select the Quantities Report by Named Boundary. 
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• Select the named boundary group. Display Clipped Graphics should not be 
checked. 
 

 
 

• This generates a report for Each Boundary. 

• The End Station and Boundary Name are identified in the left margin of each 
boundary breakdown. 
1. Station 10+00 to Station 28+00 

 
2. Station 28+00 to Station 46+00 

 
  



 

Module 15 – Earthwork 
 

 
 

Page | 60  
 
 

• In the report dialog select Tools and Format Options from the top left. 

 
 
1. Under Cubic units select Convert to Cubic Yard 
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• In this report format the Volume is in the last column on the right. 
1. The earthwork volume from Station 10+00 to 28+00 

 

 
2. The earthwork Volume from Station 28+00 to 46+00 

 

 
3. Note that added together these equal the original total of: 

 
CUT = 10,089.29 CY  
FILL = 90,211.34 CY 
 

B. Compared to the volumes reported from the component quantities tool, the 
difference in the cut is 0.1% and the difference in fill is 9.3% 

 
Component Quantities will always produce different results from the Prismoidal 
volumes because the average end area only accounts for the area at each cross 
section. These volumes were relatively close because this is a simple corridor. 
Depending on project specific situations component quantities can produce large 
errors. The designer should always be cautious when using component quantities for 
earthwork volume checks. 
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4. Shear Points 
A. Shear points are not required for earthwork calculations. Earthwork volumes are 

determined by what corridors are referenced to the EAR file and can be separated 
further using Named Boundaries. 

B. This area of the model is where Y18RPA intersects Y18. This area has been excluded 
from the earthwork calculation for Y18. 
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C. Using the average end area method the cross sections on Y18 and Y18RPA in this 
area would have to be laid out very carefully. Break Points and Shear would have 
been required to accurately compute the earthwork volume, and even then it would 
have been impossible to eliminate all errors. Using the Prismoidal Earthwork 
Calculation this area will be included in the Y18RPA Earthwork Volume and will be 
accurately reported if the intersection is accurately modeled. 
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D. This is a view of the Y8RPA earthwork shapes matching to the Y8 Earthwork shapes. 
Also note that this intersection was modeled using Linear and Surface templates and 
that the earthwork has been computed correctly as evidenced by the red fill shape. 
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Exercise 3 – Earthwork on Widening Project 
 
On widening projects, often one requirement will be to split the earthwork up based on the 
traffic control phasing. That may be left and right or various sections. This can be easily done 
using Named Boundaries. 
 
Note that named boundaries cannot be used to determine partial vertical construction. If a 
roadway was going to be raised to an intermediate elevation prior to completion and then 
raised to the final elevation at a later time and those earthwork numbers needed to be 
separated, then the designer would need to model the intermediate and final condition. 
 

In the following example we will split the earthwork Left and Right and Break it for a 
structure, Y8 over L. 
 

Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 
 
 
 
The WorkSpace is DOT_US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Create Earthwork Volumes 
A. Create a new DGN file for the Earthwork Calculation. For this exercise we will use Y8 

as the example, this alignment has a structure over Y8 and requires a break in the 
earthwork. 

• Filename 
1. R-2635C_RDY_EAR_Y8.dgn 

• Folder Location 
1. …\R-2635C\Roadway\Design 

• Seed File 
1. Seed2D – English Design.dgn 

B. Attach the required reference files: 

• Existing Terrain Model – R-2635C_NCDOT_FS 
1. Attach the Existing Terrain Model within the FS file 

 
2. Live Nesting should be OFF. 

 
3. Set Active to Create the Default 3D Model 

• Proposed Alignment for the reference corridor 
1. This is required for placing the named boundaries 

• Proposed CMD File, this exercise will calculate the earthwork volume total for a 
single Corridor. For more complicated designs include the proposed roadway, 
any hydraulic models that need to be included, any grade to drain areas or other 
special areas such as drives or small intersections that will not have a separate 
line item in the earthwork balance card.  
1. R-2635C_RDY_CMD_Y8.dgn 
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C. Create the Cut and Fill Volumes in the Default 3D Model. This is the exact same 
process used in the previous example 

• One View must be open with the Default 3D model. 

• Using the OpenRoads Modeling workflow, navigate to the Home Tab and find 
the Civil Analysis section of the Model Analysis and Reporting tool Group. The 
drop down has the toll for Create Cut Fill Volumes. 
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• Set the dialog box with optional computations unchecked. 

 

• Left click to accept selections and create the earthwork volumes. Like the 
previous example there are gaps at intersections and the structure. There are 
also gaps in the 3D Volumes in areas where wedging has been included in the 
model. All these areas are ignored for the purpose of the earthwork calculation. 
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• This process has been the same as the steps required for the simple earthwork 
calculation. At this point use the various review techniques to verify the 
earthwork volumes are correct. Using the properties dialog or the Measure 
Volume Tool can directly measure the 3D volumes in the Default 3D Model. 
 
CUT = 16542.45 CY  
 
 
 
 
 
 
 
 
 
 
FILL = 12,772.57 CY 
 
 
 
 
 
 
 
 
 
Note that the measure volume tool reports the volume in cubic feet not cubic 
yards, and it must be converted. 
 

• For reporting the quantities in the Earthwork Balance Card, we will need to split 
the earthwork into four sections because there is a requirement to break the 
earthwork for structures and we will be splitting the earthwork for the Left and 
Right sides of the Alignment. To Accomplish this, we will use named boundaries 
like the previous example. 
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2. Place Named Boundaries 
A. Named Boundaries are required to separate the earthwork. 
B. The alignment reference file should be ON in the Default model. 
C. Switch to the Drawing Production Tab in the OpenRoads Modeling workflow. 

 
 

D. Select the named boundary tool. 

 
 

• Select Civil Plan 
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• Set the dialog box as noted 
1. Drawing Seed – None (Not Required - no drawing models will be created) 
2. Detail Scale – Full Size (This is not critical) 
3. Name - EW Left 
4. Group - New 

a. Name – Y8 
EW Left 

b. Note that 
this is 
changed 
after 
selecting the 
named 
boundary 
path 

5. Length – 2000’ 
(for this 
example) 

6. Left Offset - -
500’ 

7. Right Offset – 0’ 
a. This will 

place the 
right edge of 
the named 
boundary on 
the 
centerline 
where we want the split in the earthwork to occur 

8. Overlap – 0 
9. Boundary Chords – 10 

a. This should be adjusted based on the alignment. Alignments with sharp 
curves may require more boundary curves to match the centerline. 
Tangent Alignments would not need any boundary chords. 
 

10. Create Drawing – Checked OFF 
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• Place the named boundaries 
1. This should create two boundaries on the left side of the Alignment. 
2. The break in the Boundaries should occur on the structure, the actual 

location is not critical 

 

• Repeat this process. 
1. Change the name 

to EW Right 
2. Change the Group 

Name to Y8 EW 
Right 

3. Change the Left 
Offset to 0’ 

4. Change the Right 
Offset to 500’ 
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• There should now be 4 named boundaries. 
1. This image has the centerline turned off for clarity. 
2. Note the Named boundaries in this example line up at the same station for 

the Left and Right side. That is not a requirement. More complex Traffic 
Control phasing may require the Named Boundaries to break at different 
stations. If the boundaries cover the entire model and do not overlap the 
earthwork will be reported correctly. 
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3. Report Earthwork Volumes 
A. Go back to the Home Tab and the Model Analysis and Reporting Tool Group. Under 

the Civil Analysis dropdown select the Quantities Report by Named Boundary. 
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• Select the named boundary group. Display Clipped Graphics should not be 
checked.  

 
Note that the naming of the boundary in the previous steps is not absolutely 
critical as long as the user can keep them separate, but is helpful when selecting 
the correct boundary group and creating reports. As shown in the reporting 
below it does document the name of Boundary Group so for reporting purposes 
it may be helpful is the user develops some standard naming convention. 
 

  



 

Module 15 – Earthwork 
 

 
 

Page | 76  
 
 

• This generates a report for the Left Side for Each of the Two Boundaries. The 
Bentley Civil Report Browser will automatically pop up. 
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• Because we selected Quantities by Named Boundaries that will be the default 
selected report. 

 
 

• The reports are XSL style sheets and only pull out and format information 
included in the DGN file, there is a long list of reports that pull and format 
information in various ways that may also be helpful. Additional reports are 
accessed by simply selecting different XSL files from the list on the left side of the 
dialog. 
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• This view is from the Quantities by Named Boundary Report.xsl. The End Station 
and Boundary Name are identified in the left margin of each boundary 
breakdown. 

a. Station 10+00 to Station 30+00 

 
 

b. Station 30+00 to Station 50+00 

 
 

• In the report dialog select Tools and Format Options from the top left. 
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• Under Cubic units select Convert to Cubic Yard 
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• In this report format the Volume is in the last column on the right. 
1. The earthwork volume from Station 10+00 to 30+00 

 
2. The earthwork Volume from Station 30+00 to 50+00 

 

• At this step the user should save the report. 
1. In the top left corner of the reports dialog select File → Save As 

 
 

2. Select one of the formats for the report. This is based on user preference and 
what is reported out. For this report that includes quantity totals HTML is 
probably the most appropriate. Other reports may work better in Word or 
Excel format. 
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B. Repeat this process for the boundary elements on the right side – see previous steps 
for more detail. 

• Select the quantities by named boundary tool 

• Select the boundaries on the right side 

• Review and Save the Report. 
1. For the right side the Earthwork from 10+00 to  30+00 is 

 

 
2. The Earthwork from 30+00 to 50+00 is 

 
 

C. If we add the earthwork from the four named boundaries together we get 
 
CUT = 16,542.67 Compared to 16,542.45 from the total Volume 
FILL = 12,772.54 Compared to 12,772.57 from the Total Volume 
 
The small discrepancies can be attributed to the curve in the alignment. Because the 
Named Boundary uses a chorded curve there is some small areas of overlap at the 
centerline. These are negligible and could be reduced even further by increasing the 
number of chords when placing the named boundary. Checking the Total Volume 
from the named boundary reports against the Total Volume measured directly from 
the DGN file is a good check that there are no large errors. 
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Exercise 4 – Earthwork for Hydro Ditch Designs 
 
After the hydraulic design is completed, it will be necessary to incorporate the ditch earthwork 
volumes into the project totals.  
 
Ditch earthwork is divided in to two categories: 

• DDE – Drainage Ditch Excavation 
o Lateral Ditches with a Berm 
o Lateral Ditches where the ditch front slope does not match the roadway fill slope 
o Head and Tail Ditches 

• UCE – Unclassified Excavation 
o Special Cut Ditches 
o Lateral Ditches with no Berm and the ditch front slope matches the roadway fill 

slope. 
 

Note that Berm Ditches are not included in earthwork calculations. 
 
The quantities for DDE and UCE must be computed separately. DDE is a separate pay item and 
will be documented as a separate quantity. UCE will be incorporated into the roadway 
earthwork volumes. 
 
The ditch models will be developed with Components and Feature Definitions that will be used 
to separate them. No additional work should be required to complete the earthwork 
calculations. 
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Note : Older workspace versions and custom templates 
may experience the following issue with Ditch 
Templates and feature Definitions. The following is a 
discussion of the issue and a description of the solution. 

 
Ditch feature definitions need to be set up correctly to  facilitate the calculation of UCE and DDE 
earthwork Volumes. The Volume option for DDE ditches should be set to custom. This is the 
same process used to revise and correct the pavement layer Feature Definitions 
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1. Open the DGN file that contains the Ditch Models 
2. In the OpenRoads Explorer dialog click on the Current DGN file and go to the 

Mesh Section under Feature Definitions. 
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3. Find the Feature Definitions that represent the DDE Earthwork. In this 
example they are in the DDE folder and labeled HYD_TC_Grass Berm and 
HYD_TC_Grass_Special_Ditch_DDE. 

 
 

4. Select these Feature definitions one at a time and in the Properties dialog in 
the Mesh section set the Volume Option to Custom. 

 
 

5. This should only be done for the DDE ditches. The UCE ditches should use a 
volume option of Design. 
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THIS ENDS THE SECTION ON REVISING FEATURE DEFINITIONS TO 
CORRECTLY CALCULATE DDE 
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Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 
 

 
 
The WorkSpace is DOT_US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Create the Earthwork Volumes 
A. The first step will be to compute the UCE and Roadway earthwork together. Create a 

new DGN file for the Earthwork Calculation. For this exercise we will use RPY18A as 
the example. 

• Filename 
1. R-2635C_RDY_EAR_RPY18A.dgn 

• Folder Location 
1. …\R-2635C\Roadway\Design 

• Seed File 
1. Seed2D – English Design.dgn 

• Attach the required reference files: 
1. Existing Terrain Model – R-2635C_NCDOT_FS 

a. Attach the Existing Terrain Model within the FS file 

 
 

b. Live Nesting should be OFF. 

 
c. Set Active to Create the Default 3D Model 

2. Proposed Alignment for the reference corridor 
a. This is not required but is good practice to maintain orientation in the 

project. 
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3. Proposed CMD File, this exercise will calculate the earthwork volume total 
for a single Corridor and the proposed ditches associated with the Y18A 
alignment.  
a. R-2635C_RDY_CMD_RPY18A.dgn 

b. R-2635C_HYD_CMD_RPY18A_DITCH.dgn 
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• The default model should look like the image below. 

1. Roadway model with intersections, stationing from top right to bottom left 

2. Proposed Ditch Models 

a. Tail Ditch at the beginning of RPY18A 

b. Lateral Ditch on the right that is partial UCE and Partial DDE 

c. Lateral Ditch on the left that is DDE 
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• Open a view with the Default 3D Model shown. 
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D.  Create the Earthwork Volumes. The following workflow is the same steps used in 
the earthwork calculation in Example 1. Use the OpenRoads Modeling workflow.  

• On the home Tab find the Model Analysis and Reporting Section. 

 

• Under Civil Analysis Find the Create Cut and Fill Volumes Tool. 
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• Note that this same tool is available under the Terrain Tab in the Analysis Section 
under Volumes 
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• The dialog Box should be set correctly by Default 
1. Cut Feature Definition = Volumes_Cut 
2. Fill Feature Definition = Volumes_Fill 
3. Compute Unsuitable = Unchecked 
4. Compute Custom = Unchecked 

a. By leaving this unchecked any parts of the model that have components 
with a volume option set to Custom will not be considered when the 
earthwork volumes are created. Because the ditch templates include a 
feature definition for DDE components with the Volume Option set to 
Custom, those portions of the model will not be included in these 
earthwork volumes. 

5. Compute Substrata = Unchecked 
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• Left Click for each pop-up window to accept these settings. Left click in any view 
to start the Earthwork Calculation, the 3D view must be open. 
 

 

• A processing window should appear. 

 
 

• The Earthwork Volumes will be shown as new triangulated volumes in the 3D 
view, red will be fill and green will be cut. 
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• With the Hydro Ditch Model reference turned on it is easy to see that the tail 
ditch has not been included in this UCE Earthwork calculation because tail 
ditches are DDE. When the tail ditch was modeled it used a template with the 
volume option of the component feature definitions set to None, so that portion 
of the model was not considered in this earthwork calculation because the 
Custom option was left unchecked. 
 

 
  

NO 3D VOLUMES CREATED IN 
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• Inspecting the lateral ditch at the end of RPY18A we can see that the UCE portion 
of the ditch that does not have a berm and has a front slope that matches the 
roadway front slope was included in the Earthwork Calculation and the DDE 
portion of the ditch was not included. This is a single corridor but with two 
template drops, one UCE template and one DDE template. 
 
The UCE cut volume has been highlighted to show the limits. 
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• At this point any of the various methods can be used to report and document 
the earthwork volume. 
 
For this example 
 
Cut = 1,204 CY 
Fill = 24,477 CY 
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2. Create the DDE Volumes. 
A. Create a new DGN file for the DDE Calculation. 

• Filename 
1. R-2635C_RDY_EAR_RPY18A_DDE.dgn 

a. This could be a single file for all DDE throughout a project or multiple 
files, it would depend on the project complexity and number of ditches. 

• Folder Location 
1. …\R-2635C\Roadway\Design 

• Seed File 
1. Seed2D – English Design.dgn 

• Attach the required reference files: 
1. Existing Terrain Model – R-2635C_NCDOT_FS 

a. Attach the Existing Terrain Model within the FS file 

 
 

b. Live Nesting should be OFF. 

 
c. Set Active to Create the Default 3D Model 
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2. Proposed Alignment(s) 
a. This is not required but is good practice to maintain orientation in the 

project. 
b. For this example, we are only considering the ditches for a single 

alignment but it may be desirable to reference all alignments. 
3. Proposed CMD File, this exercise will calculate the DDE earthwork volumes 

for the proposed ditches. For this process we do not want any of the 
roadway models attached. If the roadway models are attached the 
earthwork volumes will be calculated for those models and it will make it 
harder to separate the DDE Volumes. 
a. R-2635C_HYD_CMD_RPY18A_DITCH.dgn 
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B. The default model should look like the image below 

• Proposed Ditch Models 
1. Tail Ditch at the beginning of RPY18A 
2. Lateral Ditch on the right that is partial UCE and Partial DDE 
3. Lateral Ditch on the left that is DDE 
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• Open a view with the Default 3D Model shown. 
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C. The following workflow is the same steps used in the UCE calculation with the 
change being the Custom Volume Option. Use the OpenRoads Modeling workflow. 
 

 

• On the home Tab find the Model Analysis and Reporting Section. 

 

• Under Civil Analysis Find the Create Cut and Fill Volumes Tool. 
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• Note that this same tool is available under the Terrain Tab in the Analysis Section 
under Volumes 
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• The dialog Box should be set correctly by Default 
1. Cut Feature Definition = Volumes_Cut 
2. Fill Feature Definition = Volumes_Fill 
3. Compute Unsuitable = Unchecked 
4. Compute Custom = CHECKED ON 

a. By checking on the Compute Custom option for this calculation any 
components that have the volume option set to custom will be reported. 
Since our DDE Ditch templates use components that have the volume 
option set to custom they will be reported for this earthwork calculation. 

5. Compute Substrata = Unchecked 
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• Left Click for each pop-up window to accept these settings. Left click in any view 
to start the Earthwork Calculation, the 3D view must be open. 
 

 

• A processing window should appear. 

 

• The Earthwork Volumes will be shown as new triangulated volumes in the 3D 
view, red will be fill and green will be cut. 
1. There may be small volumes of fill computed because we are using 

Prismoidal volumes so all triangles are considered not just the end areas 
from the cross sections. 

 
  



 

Module 15 – Earthwork 
 

 
 

Page | 107  
 
 

• Note that the UCE and DDE have both been calculated at this stage. We will need 
to use named boundaries to separate the DDE from the UCE and report only the 
DDE volumes. Named boundaries will also serve to separate the DDE for each 
ditch. The DDE volume for each individual ditch is required to be labeled on the 
plans, and placing the named boundaries will allow volume reporting for each 
individual ditch. 
 

3. Place Named Boundaries 
A. Named Boundaries are required to separate the DDE quantities. This is like the 

process used to separate Earthwork for Station Breaks or Traffic Control 
requirements. 

• In the OpenRoads Modeling Workflow go to the Drawing Production Tab and the 
Named Boundary Group. 

 
 

• Select the By Polygon option. 
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• The first named boundary will go around the tail ditch at Station 5+60 RT. 
1. Set the name and description to HAT_+60_RT 

a. This could be anything that the designer chooses but should allow for this 
ditch to be identified in the quantity report. 

2. Set the Group to New 
3. Set the name to RPY18RA_DDE 

a. This name should identify the group of ditches that will be in the DDE 
calculation. If the designer is going to place all the DDE for an entire 
project into one DGN file this could be the TIP#, i.e. R-2635C_DDE. For 
this example, the name matches the alignment used as a reference for 
the ditches. The names aren’t critical, but the designer should use a 
naming convention that allows for identification of the ditches and area 
of the project included in the earthwork calculation. 

4. Create Drawing should be unchecked. 
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• Place a named boundary around the tail ditch at the beginning of the alignment. 
The shape of the named boundary is not critical here because this ditch corridor 
does not cross another corridor and there is nothing adjacent that would affect 
the quantity report. 
1. Left click to start the shape 

 
2. Left click to place additional corners that will enclose the ditch model. 
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3. Snap to the first point and left click to close the boundary. 
 

 
 

4. Left lick again to accept the named boundary. It should enclose the ditch but 
the actual shape is not critical. 
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• Under the Named Boundaries dialog there will be a group for RPY18RA_DDE and 
a named boundary for HAT_5+60_RT 
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• The next named boundary will be for the DDE ditch at Station 12+32 RT. This 

ditch is part of a corridor that contains both a UCE ditch and a DDE ditch. In the 

OpenRoads Modeling Workflow go to the Drawing Production Tab and the 

Named Boundary Group. 

 

Select the By Polygon option. 

1. Set the name and description to DDE12+32_RT 
a. This could be anything that the designer chooses but should allow for this 

ditch to be identified in the quantity report. 
2. Set the Group to RPY18RA_DDE 

a. This is the previously created group and will add this named boundary to 
the same group at the HAT Ditch from the previous steps. When the 
quantities report is created all these boundaries will be in the same 
report. 

3. Create Drawing should be unchecked. 
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• Place this named boundary to only enclose the region of the model that includes 
the DDE Ditch 
1. Look for the separation at the template drop and snap to the end of one of 

the triangles or template lines that separates the UCE and DDE ditch. 

 
 

2. Snap to the point that separates the drops on the opposite side of the ditch. 
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3. Complete the named boundary with the same method used to place the 
boundary around the HAT ditch in the previous steps. The remaining points 
are not critical, it is only important that the shape enclose the DDE section of 
the ditch without crossing any other portions of a model. 
 

 
  



 

Module 15 – Earthwork 
 

 
 

Page | 115  
 
 

• The last step is to enclose the DDE ditch at Station 12+37 LT. This ditch is entirely 
DDE, and the shape can be placed with the same method that was used for the 
HAT ditch previously. Make sure to name the boundary correctly and select the 
previously created group. 

 
 

• At this point there should be 3 named boundaries in the drawing. The named 
boundaries should all enclose a single DDE ditch but not cross any other parts of 
the model. 
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• Reviewing the named boundary dialog should show a single group under the 
Other Groups Drop Down and 3 named boundaries. These should all be named 
in a way that allows the designer to determine which named boundary from the 
report matches to which ditch in the design file. 
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4. Report the DDE quantities 
A. Under the OpenRoads Modeling workflow switch to the Hom tab and find the Model 

Analysis and Reporting section. 
 

 

• Under Civil Analysis find the Quantities Report by Named Boundary Tool. 
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• Select the RPY18RA_DDE Named Boundary Group. 
1. Display Clipped Graphics should be checked OFF 

 
 

2. This still generates a quantities report for all the ditches at one time with 
each one reported in a separate section. 
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• Take note of the report units 

 
 

• And change them under Tools – Format Options if necessary. 
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• Note that as a true Prismoidal volume calculation some sections may show a 
small fill number. This is not unexpected and is likely a result of tying in the ditch 
to existing ground or a small scour area in the existing ditch that is being filled in. 

 
 

• This report can be saved into various formats for documentation and used to 
update the ditch labels on the plans. For ditch templates that include Rip Rap 
and Geotextile those quantities will also be reported here. 
 

B. The final note on DDE quantities is that if the ditches are revised the same named 
boundaries can be used to rerun the report, if they enclose the new ditch limits, and 
generate new quantities very easily. If one of the ditches got longer or shifted out of 
the named boundary the boundary shape can be adjusted using the standard 
drafting tools, or a boundary could be deleted from the group and a new boundary 
added.  
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Exercise 5 – Earthwork for Project with Onsite Detour 
 

In this exercise we will work through the process of calculating earthwork volumes for a project 

with an onsite detour. This is a common exercise for bridge replacement projects and in 

projects where a bridge is replacing an at grade intersection. In these situations, the designer 

will create a detour model that is based on existing ground and a final proposed model that is 

based on existing ground, but the earthwork needs to be calculated differently. There will be: 

• Earthwork required to build the detour.  

a. Yellow and Red Shapes 

• Earthwork required to build the final, excluding the overlap of the detour. 

a. Blue Shape 

• Earthwork required to remove the detour, including any additional 

excavation required and excluding the portion that need to remain for the 

final. 

a. Yellow and Green Shape 

 

This process will require some special workflows to calculate and report the earthwork volumes 

correctly. 
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This is the general workflow for computing earthwork that includes detour removal. 

Note that the workflow described below will create multiple new files. It is possible to 

combine the steps into a single file as the user becomes more comfortable with the 

models that are being created. For simplicity and clarity, the steps in this example have 

separated. 

 

1. Create Terrains for the Detour Model and the Proposed Final Model 

 

2. Create a complex terrain by merging the Proposed Final Model with the Existing Terrain. 

 

3. Create a complex terrain by merging the Detour Model with the Existing Terrain. 

 

4. Create a Closed Mesh using the Detour Model as the Top Surface and the complex terrain 

created from the Proposed Final Model and the Existing Terrain as the Bottom Surface 

(step 2). This will create a volume that represents the yellow and green area in the 

Detour Removal Schematic. This Closed Mesh can be used by the program to calculate 

the detour removal volume. 

 

5. Run the earthwork volume calculation using the same steps as the basic calculation using 

the Proposed Final Model as the proposed grade and the complex terrain created with 

the Detour Model and the Existing Ground as the existing grade (step 3). With the 

Custom option selected in the earthwork calculation the Closed Mesh Volumes will be 

included and the final earthwork including the detour removal will be calculated and 

reported. 
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Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 
 

 
 
The WorkSpace is DOT_US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Create a Proposed Terrain – Final Roadway and Detour Model 

A. The first step is to create proposed terrains for the final roadway model and the 

detour model. Depending on the complexity of the project and the number of 

components required for the proposed and detour model, the steps required for this 

process may vary from the steps shown below. There are also alternate methods 

that may be more appropriate based on the specific project. The only requirement is 

a proposed terrain model for the detour and the final roadway. 

 

B. Create a terrain from the Y8 Corridor. 

• For this example, we will use a graphical filter to create the proposed surface. 

The Graphical Filter tool uses a filter to select certain 3D elements from the 

model(s), generally by feature definition. These elements are grouped into 

various categories such as; boundaries, break lines, voids etc. These elements 

are then combined into a terrain model. The biggest benefit of using this method 

is that it can combine multiple corridors, linear templates and detailed areas into 

a single terrain in one step. 
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C. Create New DGN File for the proposed final roadway terrain. For this example, we. 
Create this file in the Roadway\Design folder. 

• Filename 
1. R-2635C_RDY_PTM_Y8.dgn 

a. It is possible to create the proposed terrain in the CMD file, but the 
recommended workflow is to use separate files. If they are in the same 
file, the proposed terrain will reprocess every time the corridor is 
updated. 

• Folder Location 
1. …\R-2635C\Roadway\Design 

• Seed File 
1. Seed2D – English Design.dgn 

• Attach the R-2635C_NCDOT_FS.dgn file selecting the existing terrain model and 
set the terrain active to generate the Default 3D model. 

 
 

• Open a view window for and the Default 3D model 
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D. Attach Proposed Y8 Corridor. 

• When attaching corridor files attach the Default model to the Default model in 
the current DGN file. This will automatically attach the Default 3D model to the 
Default 3D model in the current DGN file. 

• Filename 
1. R-2635C_RDY_CMD_Y8.dgn 

 

 
 

• For this example, Y8 is a single corridor but if there were areas of detailed 
modeling that included surface templates, linear templates or separate corridors 
those should be attached. All the models required for the final proposed 
condition should be used. 
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E. Create a Graphical Filter 

• Graphical Filters for specific projects and templates may or may not be available 

in the NCDOT Workspaces. 

• Creating a Graphical Filter is not difficult and can be accomplished on a project-

by-project basis if required. This will also allow for the inclusion of custom 

feature definitions. 

• The Graphical Filter Tool is located in the Terrain Tab in the Create tool Group. 
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• Select the Graphical Filter Manager from the drop down 

 

• The dialog includes a list of available Filters and Filter Groups and tools that 

allow for the creation of new Filters and Filter Groups. 
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• For this exercise we will create a new Graphical Filter Group that will be used to 

create the Proposed Terrain 

• The first step is to create new Filters. These are used to group elements into 

specific categories based on how they will be used to create the Terrain model. 

• Select the Create Filter tool from the Terrain Filter Manager Dialog. 

 

• This will activate the Properties section of the dialog in the right side of the 

Manager window. 
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• Set the Name to Proposed Boundary. 

• A description can be added but is generally not necessary for simple filters 

 

 

• Set the Feature Type to Boundary. There will be a long list of available features in 

the drop down. For roadway models we will generally be interested in 

Boundaries and Break Lines. 
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• The General Section for the dialog should match the screen shot below. Now 

select the Edit Filter button. 

 

• The Edit Filter command will activate a new dialog that will display all the ways 

that elements can be selected in the DGN file.  
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• As a general rule the easiest and most consistent method to creating the filter 

for roadway models it to use the Civil Features Section. These are the Feature 

Definition assigned to the points at the Template Level. These feature definitions 

should be consistent when using the default template library or custom project 

specific templates. By clicking on the Civil Features Section a list will populate 

listing all the available features within the workspace. Note that the user will 

need to be in the correct “Role” to see all the available features, for this exercise 

it is Roadway but it could be the Roadway-Hydraulic Combination role. 
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• For this Filter group we want to select the boundary elements. By selecting the 

boundary of the Roadway Model we can determine the Feature Definition of the 

boundary element. 

1. TL_Limits of Construction.  

• This also shows us the Path where the feature definition is located. 

1. Linear\Roadway\Template Points\Grading\TL_Limits of Construction 

 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 134  
 
 

• In the Filter dialog find the matching Feature definition. 

 

 

• Select the ADD button in the top middle of the dialog. 
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• This will add the feature to the right side of the dialog in the Selected Features 

pane. Then select FINISH in the bottom right corner of the dialog. 

 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 136  
 
 

• This will reactive the Terrain Filter Manager. Note that the Feature Definition 

selection is checked in the Filter By Section indicating that the Filter has been set 

correctly. 
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• The next step is to create a Filter for the required Break Lines. Select the New 

Filter button. 

 

 

• Set the Filter name to Proposed Grading Break Lines and the Feature Type to 

Break Lines. 
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• Select Edit Filter 

 

• Similar to selecting the boundary elements we will select the feature definitions 

that make up the break lines from the model using the Civil Feature section. 
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• Another way to determine the required feature definitions for the filter is to 

review the standard roadway templates. Since the standard templates generally 

use the same features it is not difficult to select them from the available list.  
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• For the grading surface we want to use any ditch points and the subgrade line. 

Those feature definitions are all located in the Root Folder 

1. Linear\Roadway\Template Points\: 

a. From the Grading Sub Folder 

i. TL_Cut Slope Hinge 

ii. TL_Ditch Base Back 

iii. TL_Ditch Base Front 

iv. TL_Ditch Base Mid 

v. TL_Median Ditch Base Center 

vi. TL_Subgrade Daylight Inside 

vii. TL_Subgrade Daylight Outside 

b. From the Pavement Sub Folder 

i. TL_Centerline Subgrade 

ii. TL_Edge of Travel Inside Subgrade 

iii. TL_Edge of Travel Outside Subgrade 

iv. TL_Exist EOP 

1. Required for wedging templates with no end conditions 

c. From the Shoulder and Berm Sub Folder 

i. TL_Grass Berm Normal 

1. Required for Curb and Guter Sections 

ii. TL_Grass Berm Widen 

1. Required for Curb and Gutter Sections 

iii. TL_Grass Shoulder Normal Inside 

1. Required for Trench Sections – Omit for Graded Sections 
iv. TL_ Grass Shoulder Normal Outside 

1. Required for Trench Sections – Omit for Graded Sections 

v. TL_Grass Shoulder Widen Inside 

1. Required for Trench Sections – Omit for Graded Sections 
vi. TL_Grass Shoulder Widen Outside 

1. Required for Trench Sections – Omit for Graded Sections 
vii. TL_Paved Shoulder Inside Subgrade 
viii. TL_Paved Shoulder Outside Subgrade 
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• For this example we are using a Shoulder Section template with a median ditch 
and a graded section subgrade. Select the following Feature definitions and Add 
to the Filter list. Then Select Finish.  
 
Note that by holding down the CTL key multiple Feature Definitions can be 
selected at one time. 
1. TL_Cut Slope Hinge 
2. TL_Ditch Base Back 
3. TL_Ditch Base Front 
4. TL_Ditch Base Mid 
5. TL_Median Ditch Base Center 
6. TL_Subgrade Daylight Inside 
7. TL_Subgrade Daylight Outside 
8. TL_Centerline Subgrade 
9. TL_Edge of Travel Inside Subgrade 
10. TL_Edge of Travel Outside Subgrade 
11. TL_Paved Shoulder Inside Subgrade 
12. TL_Paved Shoulder Outside Subgrade 
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• There will now be 2 filters listed in the Filter Manager Dialog. 

 
 

• The next step is to create a Filter Group. This will group multiple filters together 
into a selection that can be used by the graphical filter dialog to create a terrain 
model. Highlight the File Name section and select the Create New Filter Group 
button. 

 
 

• Set the Filter Naem to Proposed Grading 
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• Under the Select Filters drop down select the previously created Filters 
1. Proposed Grading Break Lines 
2. Proposed Boundary 
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• The dialog should now show the two Filters listed under the Filter Group 
 

 

• Select Finish 
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F. Create the Proposed Terrain for Y8 

• Go back to the Terrain Tab and select the From Graphical Filter tool. 
 

 

• Click the select icon in the Graphical Filter Group line 
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• Select the Proposed Grading Graphical Filter Group 

 
 

  



 

Module 15 – Earthwork 
 

 
 

Page | 147  
 
 

• Set the remaining dialog as follows 
1. Append to Terrain = Unchecked 
2. Edge Method = Remove Slivers 
3. Feature Definition = PT_Traingles 
4. Name = PTM Y8 
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• Left Click to accept the selections and Create the Proposed Grading Terrain. The 
Default 3D view should show the proposed triangles and boundary. 

 

• We can also see the terrain by turning on the Default 3D reference in the Default 
model. 
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G. Edit the Proposed Terrain 

• Notice there are some areas where the terrain has calculated incorrectly, these 
are areas where the boundary element was not located due to end condition 
exceptions in the model. These areas are relatively easy to correct. Select the 
Edit model Tool from the Terrain Tab. 

 
 

• Select the Delete Triangles by Line tool. 

 
 

  



 

Module 15 – Earthwork 
 

 
 

Page | 150  
 
 

• Left click on the Proposed Terrain, this can be done in the 2D Default Model. 
 

 
 

• Left Click on hold down the mouse button to draw a line across the triangles that 
should be deleted. 
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• This will eliminate any triangles that are incorrect. 
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• Repeat this process until the Terrain has been revised and matches the grading 
surface of the model.  
 
Note that this Terrain is going to be used to create a 3D Volume in later steps 
that represents the detour removal. This terrain is not going to be used for the 
actual Cut and Fill Earthwork Volumes. This terrain does not need to perfectly 
match the proposed roadway model everywhere, it only has to match in areas 
where the proposed roadway model overlaps the proposed detour model. For 
this example the detour is on the left side of Y8. So, we only need to correct the 
triangulation in the areas on the left side. 
 
In this image we can see we have corrected the triangles on the left side of Y8 
(top of the image) and disregarded the triangles on the right side of Y8. 
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2. Create a Proposed Terrain – Detour 
A. This is the exact same process but will use the Detour Model instead of the 

Proposed Roadway Model. 
B. Create a new DGN file for the Detour Terrain 

• R-2635C_RDY_PTM_Y8DET.dgn 

• Folder Location is Roadway\Design 

• Use the 2D Seed File 

• Attach the R-2635C_NCDOT_FS.dgn file selecting the existing terrain model and 
set active 

• Attach R-2635C_RDY_CMD_Y8DET.dgn 
1. When attaching corridor files attach the Default model to the Default model 

in the current DGN file. This will automatically attach the Default 3D model 
to the Default 3D model in the current DGN file. 

C. Create a Graphical Filter 

• Using the Graphical Filter Manager 
a. Create a Filter for the Proposed Boundary from the Feature Definition 

i. TL_Limits of Construction  
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b. Create a Filter for the proposed Break Lines from the Feature Definitions 
i. TL_Cut Slope Hinge 
ii. TL_Ditch Base Back 
iii. TL_Ditch Base Front 
iv. TL_Ditch Base Mid 
v. TL_Median Ditch Base Center 
vi. TL_Subgrade Daylight Inside 
vii. TL_Subgrade Daylight Outside 
viii. TL_Centerline Subgrade 
ix. TL_Edge of Travel Inside Subgrade 
x. TL_Edge of Travel Outside Subgrade 
xi. TL_Paved Shoulder Inside Subgrade 
xii. TL_Paved Shoulder Outside Subgrade 

 

 
c. Create a Filter Group named proposed Grading from the Filters 

i. Proposed Boundary 
ii. Proposed Break Lines 
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D. Create the Proposed Terrain for Y8DET 

• Using the From Graphical Filter tool and the Proposed Grading Filter Group 
create the proposed terrain. 

• Terrain name is PTM Y8DET 
E. Edit the Proposed Terrain 

• Using the Edit tools edit the terrain triangles as required 

• For the Detour this is an important step, these triangles must match the model 
everywhere. This Terrain will be merged with the Existing Terrain and used as 
the basis for the Cut and Fill volumes for the Final Roadway. 
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3. Create the Complex Terrain for the Final Roadway 

A. A complex terrain is a combination of two different surfaces. 

B. This complex terrain in conjunction with the Detour Model will be used to create the 

3D Volume that represents the detour removal.  

• This volume is represented by the Yellow and Green shape in the Detour 

Removal Schematic shown on the first page in this section. 

C. Create a new DGN file 

• R-2635C_RDY_CTM_Y8.dgn 

• Attach R-2635C_NCDOT_FS.dgn using the Existing Terrain model and set it active 

 

• Live Nesting should be OFF. 
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• Attach the Proposed Y8 Terrain created in previous steps in the  

R-2635C_RDY_PTM_Y8.dgn file 

1. When attaching terrain files attach the Default model to the Default model in 
the current DGN file. This will automatically attach the Default 3D model to 
the Default 3D model in the current DGN file. 
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D. Merge the proposed terrain into the existing terrain. 

• In the OpenRoads Modeling workflow in the Terrain Tab find the Create Tool 

Group. 

 

 

• In the Additional methods drop down find the Create Complex Terrain Model 

tool. 
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• The dialog should show 2 available Terrains 

1. P_Y8 – Proposed Final Roadway Terrain Created in Previous Steps 

2. r2635c_ph_tin_040927 – the Existing Terrain 

 

 

• Select Each Terrain and left click 

1. rR2635c_ph_tin_040927 is the Primary  

2. P_Y8 should be set to Merge 
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• At the bottom of the dialog set the Feature Definition to PT_Traingles and set 

the name to Y8_Merge. By using this setting, the existing terrain will effectively 

be removed and replace by the Proposed Final Roadway terrain in areas where 

they overlap. 

 

• Left Click Finish. Turn the reference files off, Do Not Detach the files. This will 

display a newly created Terrain that includes the Proposed Y8 construction 

merged into the existing ground. 
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• The 3D view will display the terrain more clearly. The area with the regular 

pattern of triangles represents the proposed terrain and the area with the 

irregular pattern represents the existing triangles. 
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4. Create the Complex Terrain for the Detour 

A. This complex terrain will be used as the existing ground when completing the 

Prismoidal Earthwork calculation. This is required to exclude any previously placed 

fill or any completed excavation from the Detour construction from being calculated 

again. 

B. Create a new DGN file 

• R-2635C_RDY_CTM_Y8DET.dgn 

• Attach R-2635C_NCDOT_FS.dgn using the Existing Terrain model and set it active 

 

• Live Nesting should be OFF. 
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• Attach the Proposed Y8DET Terrain created in previous steps in the  

R-2635C_RDY_PTM_Y8DET.dgn file. 

1. When attaching terrain files attach the Default model to the Default model in 
the current DGN file. This will automatically attach the Default 3D model to 
the Default 3D model in the current DGN file. 
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E. Merge the proposed terrain into the existing terrain. 

• In the OpenRoads Modeling workflow in the Terrain Tab find the Create Tool 

Group. 

 

 

• In the Additional methods drop down find the Create Complex Terrain Model 

tool. 
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• The dialog should show 2 available Terrains 

1. P_Y8DET – Detour Terrain Created in Previous Steps 

2. r2635c_ph_tin_040927 – the Existing Terrain 

 

 

• Select Each Terrain and left click 

1. rR2635c_ph_tin_040927 is the Primary  

2. P_Y8 should be set to Merge 
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•  At the bottom of the dialog set the Feature Definition to ET_Boundary and set 

the name to Y8DET_Merge. By using this setting, the existing terrain will 

effectively be removed and replace by the Detour terrain in areas where they 

overlap. 

 

• It is very important to use the Existing Terrain Feature Definitions. This terrain 

will be used later as the existing ground for Earthwork Volume calculations. The 

Existing Terrain Feature Definitions are configured correctly for this use. If the 

Proposed Terrain Feature Definitions are used the program will not recognize 

this terrain as existing ground. 

• Left Click Finish. Turn the reference files off, Do Not Detach the files. This will 

display a newly created Terrain that includes the Proposed Y8 construction 

merged into the existing ground. 

• Turning off all reference files and highlighting the boundary will display the 

Terrain name and verify the merged terrain has been created. 
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4. Create the Detour Removal Closed Mesh. 

A. This Closed Mesh will represent the amount of detour removal required at the end 

of a project. It represents previously placed Detour fill volume plus any excavation 

required during the detour removal for the Final grading.  

• This volume is represented by the Yellow and Green shapes in the example 

figure and must be quantified and shown as removal. 

• The work to this point was required to generate the surfaces that will be used to 

create the earthwork Volumes.  

• Closed Meshes are 3D elements that will be used to separate out the Earthwork 

Volumes. 

B. Create a new file for the Closed Mesh Volumes 

• R-2635C_RDY_EAR_Y8_Mesh.dgn 

1. Attach the Proposed Final Y8 Complex Terrain R-2635C_RDY_CTM_Y8.dgn 
and set this file active. 

2. Attach the Proposed Y8DET Terrain R-2635C_RDY_PTM_Y8DET.dgn 

3. When attaching the terrain files attach the Default model to the Default 
model in the current DGN file. This will automatically attach the Default 3D 
model to the Default 3D model in the current DGN file. 

 

4. Live Nesting should be OFF. 
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C. Create the Detour Removal Closed Mesh. 

• Switch to the OpenRoads Modeling Workflow and the Model Detailing tab. 

 

 

• In the 3D Section select the Create Closed Mesh tool. 

 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 169  
 
 

• In the dialog box set 

1. Method to Element to Element 

2. Feature Definition to Detour Removal from the Roadway/Modeling Folder  

 

 

• Left click to verify the Method 
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• A prompt will appear to select the top surface. Select the proposed detour 

surface by selecting the boundary element for the detour surface, reset to 

confirm the selection. 
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• The prompt will then ask for the bottom surface. Select the complex terrain 

model that is the Existing and Final Proposed surface merged. Select anywhere 

on the terrain triangles of the terrain. Reset to confirm the selection. 

 

 

• The prompt will change to ask for Boundary Surface Elements. Because we want 

to analyze the entire Detour Surface for Earthwork removal reset to skip this 

selection, it is not required for this workflow. 
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• Left Click to accept the Feature Definition 

 

 

• Left Click – Data Point in the Default 3D model to create the closed mesh. 

 

 

• Turning off the Terrain Model References will reveal a yellow closed 3D mesh. 
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• This represents the volume of earth placed for the Detour that will be removed 

after the Final Construction. This is more visible in the Modeling View mode. 

 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 174  
 
 

• Attaching the corridors and alignment and activating the Dynamic Cross sections 

also gives a good view of the volume. Here the yellow volume represents the 

volume of material that will need to be removed for the final construction. This 

is the dynamic section view at Station 24+75 from the Y8 Corridor. 

 

 

 

 

• Note that the example files included with this exercise do not include all the 

detailed modeling that would be required for a final set of plans. The final 

construction of Y8 does not necessarily account for the previously removed 

earth required for the detour construction. A completed project would include 

more detail, and these areas would be accounted for. These files are only meant 

to represent the overall workflow. 
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5. Calculate the Earthwork Volumes. 

A. This is the final step in computing the earthwork volumes. This will be the same 

process used for the basic Earthwork Calculation but will include the detour 

removal.  

B. Open the Y8 Earthwork File that was created in the first exercise. 

• R-2635C_RDY_EAR_Y8.dgn 

• This file will have previously created earthwork cut and fill volumes and named 

boundaries. 

C. At this point we need to replace the existing terrain with the complex terrain 

created by merging the Detour and the Existing Terrain. This will prevent the 

program from calculating Cut and Fill volumes in areas that were completed during 

the detour construction phase. 

• Detach the existing terrain file 

1. R-2635C_NCDOT_FS.dgn 

2. If a Probable Dependencies error message appear select YES and detach the 

existing terrain. 

 

• Attach the Detour Complex Terrian Model 

1. R-2635C_RDY_CTM_Y8DET.dgn 

2. Live Nesting should be OFF 

3. Set this as the Active Terrian 
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• Attach the Detour Removal mesh file created in previous steps. 

1. R-2635C_RDY_EAR_Y8_MESH.dgn 

 

 

• These meshes are 3D volumes, the Default 3D reference must be on in the 

Default view to see the shapes. 

• These shapes, shown in yellow, should be enclosed in the previously created 

named boundaries but if not make any adjustments to the named boundaries 

using the MicroStation drafting tools. 
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D. This is an image of the cross section at Station 24+80. The Yellow area represents 

the Detour Removal Volume. This volume will be reported in the quantities report. 

This volume will also prevent a Cut volume from being Calculated for the Y8 

Construction. The area above the yellow volume was excavated previously for the 

detour construction. 

 

Shown without the Detour Model 

 

Shown with the Detour Model – Note that the existing ground is represented by the 

Y8 Detour Complex terrain model. 

 

 

  

Y8 DETOUR 
COMPLEX TERRAIN 

MODEL 

Y8 DETOUR 
COMPLEX TERRAIN 

MODEL 
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E. Create the Cut and Fill Volumes in the Default 3D Model. 

• One View Must be open with the Default 3D Model. 

• Using the OpenRoads Modeling workflow, navigate to the Home Tab and find 

the Civil Analysis section of the Model Analysis and Reporting tool Group and 

select the tool for Create Cut Fill Volumes. 
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F. Set the dialog box with Compute Custom checked on. By selecting Compute Custom, 

the Detour Removal Shape will be included in the Earthwork Calculation which will 

prevent the cut or fill volumes from being computed in areas where there is detour 

removal. 

 

 

G. Left Click to accept the Calculation Settings. 
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F. At the next prompt select Yes to delete previous results. 
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F. After the new Cut and Fill Volume Meshes are created it is clearly visible that the 

volumes for the detour removal and the detour to remain have been included and 

correctly calculated by the program. 

• We see all the volumes in the 3D view. 

 

• By turning of the Detour Mesh Reference file we can see that Cut and Fill have 

not been included where the Detour Meshes were located. This is because those 

Closed Mesh Volumes use a feature definition that has the Volume Option set to 

Custom and the Compute Custom Option was selected when computing the Cut 

and Fill Volumes. 
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• At station 24+95 we can see the yellow volume that indicates the detour 

removal that will need to be accounted for to create the roadway ditch section. 

 

 

 

• Note that the provided corridor models are preliminary stage and may not 

include all the detail required for the finished models and that some volumes 

may not account for the final design earthwork completely accurately. The 

workflow is the same at all design stages. 

  

Y8 DETOUR 
COMPLEX TERRAIN 

MODEL 
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6. Report Quantities 

A. Go back to the Home Tab and the Model Analysis and Reporting Tool Group. Under 

the Civil Analysis dropdown select the Quantities Report by Named Boundary. 

 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 184  
 
 

• Select the named boundary group. Display Clipped Graphics should not be 

checked. 

 

 

B. Just like the previous exercise, this generates a report for the Left Side for Each of 
the Two Boundaries. 

• There is a Volume for Cut, Fill and Detour Removal that will be included in the 

Earthwork Balance Card. 

 

 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 185  
 
 

D. By Comparing these numbers to the previous computation, we can see that the 

inclusion of the new Closed 3D Meshes has been incorporated into the new 

Earthwork Calculation. 

 

• Scenario 1 - Performing the calculation without the Custom Option selected the 

Detour Removal is Ignored and from Station 10+00 to 30+00. Using the Existing 

Terrain as the Existing Ground for the earthwork Calculations. 

 

The earthwork volumes are: 

1. Fill = 2528.52 CY 

2. Cut = 2770.18 CY 

3. Detour Removal = 0 CY 

 

• Scenario 2 - In the next Calculation from Station 10+00 to 30+00 the Custom 

Option is checked on and the Detour Removal included. The Complex Terrain 

that includes the completed Detour surface is also used as the Existing Ground  

for the earthwork Calculations. 

 

The Earthwork Volumes are: 

1. Fill = 2688.34 CY 

2. Cut = 2365.41 CY 

3. Detour Removal = 152.04 CY 

 

• We can see that the Cut number has been reduced, the Fill Number has been 

Increased and that the Detour Removal number is now included. 
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E. `If we refer to a representative section from the project we can see that these 
results match our expectations. This is the section at Station 29+00 showing Detour 
Construction on the left and Proposed Roadway Construction on the right. 

 
A closer image where the Detour and Proposed overlap 

 
A key point to remember is that for Scenario 1 we used the Existing Terrain as the 
Existing Ground and in Scenario 2 we used the Complex Terrain with the Proposed 
Detour as the Existing Ground. 
 
We can see that the Detour is lower than the Proposed Roadway. 
 
The proposed Roadway Construction will require Fill to backfill the detour ditch. The 
requires the Fill Volume in scenario 2 to be larger than the Fill Volume in Scenario 1. 
 
A portion of the Excavation for the Final Roadway has already been completed 
during the Detour Construction. The Cut Volume should be lower in Scenario 2 than 
in Scenario 1. 
 
These changes in Volumes will be different for each project based on the specific 
relationship of the Detour to the Proposed construction, but it should not be difficult 
to review the model and determine that the final volumes including the Detour 
Removal have been reported correctly. 

  

Y8 DETOUR  

Y8 DETOUR  Y8 

Y8 
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Exercise 6 – Earthwork Checks and Documentation 
 
Another critical factor in project development is the QA / QC process. The calculated earthwork 
volumes must be verified. With the Prismoidal Volume Calculation method the earthwork 
volumes are a true 3D volume based on the triangulated networks of the existing and proposed 
surfaces. While this is more accurate than the Average End Area method it does present some 
challenges when the volumes need to be checked and verified. 
 
With the Average End Area method users could physically measure the area at each cross 
section and check them against the calculation looking for errors. This was simple and 
straightforward and ensured that the earthwork volumes matched the cross sections. The 
problem was the earthwork volumes did not actually match the project because many areas 
were not included in the average end areas. Designers accepted the known difference in 
calculated vs. actual earthwork as a product of the process and available methods. This concept 
was explained in detail in the beginning of this training. 
 
Now that Prismoidal Volume Calculations are available the designer can compute much more 
accurate earthwork volumes because each triangle in the existing surface is used to calculate a 
true 3D volume. This concept is also documented in detail at the beginning of this training. The 
tradeoff for using this method is there is no way to exactly backcheck the volume calculation 
with an independent method and verify the total quantity.  
 
But there are several methods the designer can use to have a high level of confidence that the 
number is correct. Remember that with the Average End Area method it was never possible to 
verify the earthwork calculation was going to match the actual project earthwork, the designer 
was also certain that it wouldn’t match because there is no way the Average End Area could 
account for all the irregular areas throughout a project. With the Prismoidal method the actual 
number cannot be back calculated, but the designer can have a higher level of confidence that 
the number more accurately reflects the actual earthwork volumes that will be required to 
construct the project. 
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Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 

 
 
 
The WorkSpace is DOT_US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Earthwork Check – Visual Inspection. 
A. The simplest method to verify the accuracy of the 3D volumes is visual inspection of 

the earthwork DGN files. 

• Open the R-2635C_RDY_EAR_RPY18A.dgn CADD file 
1. This file has previously created earthwork volumes 

B. Open the Default 3D model in a View. 

• This is done by selecting the View Attributes dropdown from the top left corner 
of the view window and selecting Default 3D from the Models Drop down list at 
the bottom of the dialog. 
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C. Change the presentation to Illustration Modeling 

• This is done by selecting the View Attributes dropdown from the top left corner 
of the view window and selecting Illustration Modeling from the Display Style 
Drop Down 
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D. Adjust the brightness of the display to the desired level by changing the lighting 
settings. 

• This is done by Unchecking the Default Lighting Box and Adjusting the slider to 
change the level of the lighting intensity. This is a personal preference. 

 
 

E. Thes setting have the effect of shading in the 3D volumes and making them easier to 
visually inspect. The first thing to notice is that there are no earthwork volumes 
shown in the ditches that are computed as DDE. 
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F. The first thing to notice is that we do not see and RED Shapes representing fill or 
GREEN Shapes representing cut that look out of place. It generally looks like the 
project corridor. 
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G. The designer can also zoom in and rotate the view in 3D too look at areas in more 
detail. 

• Zoom into the area in the top right corner near the intersection and we see that 
it looks like the volume has been sheared correctly with the intersecting 
roadway. 
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• It may be desirable to rotate the view and review this area from different angles. 
Rotating a view in 3D can be a challenge. 

• Select View Rotation from the View window tool group and set the method to 
Dynamic. 

 
 

• In the view Window Snap to a corner on the 3D volume shape. A large cross 
shape should appear, this is an anchor point for the view rotation. 
 

 
  



 

Module 15 – Earthwork 
 

 
 

Page | 195  
 
 

• By manipulating the mouse, the view will rotate around this point. From this 
angle we can see that the earthwork volume is vertical on the edges at the shear 
location and the designer can have a high level of confidence that the earthwork 
has been computed correctly. 
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H. By zooming into a new location and rotating the view we can see that the part of the 
ditch that was computed as UCE is shaded and the part that was computed as DDE 
was not. The designer can have confidence that the DDE section of the ditch is not 
included in the earthwork volume calculation. 
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I. For a closer view of how the volumes match to the existing ground, turn on the 
existing terrain reference. If the triangles are not displayed, they will need to be 
turned on. 

• In the 3D view use the element selection tool to highlight the terrain boundary, 
this is a yellow dashed element. 
 

 

• By moving the selection away from the terrain element and back to it the pop up 
menu will be activated. Select the Properties Icon. 
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• In the properties dialog set the override symbology to YES 
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• Set the Override Template to ET_Traingles 

 
 

J. With the triangles displayed the designer can use the Zoom and Rotate view 
function to review how the shapes match to the existing terrain. 

• By looking down from the top we can see the dark green matches the top of 
lighter green cut volume 
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• By rotating the view to review from underneath the model we can see that the 
dark green shape matches the bottom red fill volume 
 

 

• This is what we would expect from both of these volumes. 
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K. The final Visual check is to review the 3D earthwork Volumes against the proposed 
model. 

• Make sure the 3D view is active by selecting the window. 

• In the reference dialog turn on all the references, this should include the 
proposed model. 
1. R-2635C_RDY_CMD_RPY18A.dgn 

 

 

• By reviewing the 3D view using the same Zoom and Rotate tools we can see that 
the proposed model does match the 3D Earthwork Volumes. It is obvious that 
any discrepancies would be easily spotted. 

 
L. Just through a simple visual inspection the designer can have a high level of 

confidence that the earthwork volumes have been calculated correctly. 
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2. Earthwork Check – Review the Dynamic Sections 
A. Open the Dynamic Section View  

• Use the Dynamic Section tool in the OpenRoads Modeling workflow and the 
Corridors tab in the Review Section. 

 

• The tool provides an option to select the Corridor or Alignment. The Cut and Fill 
areas and volumes are only displayed if the Corridor Option is used at this step. 

 

• After the corridor is selected the prompt will be to click in an open window. Left 
click in the Default 3D view to display the dynamic cross sections. 
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• Note the view style will still be set to Illustration Modeling and it is probably 
easier to review the sections using the wireframe mode. Select View Attributes 
from the top left corner, in this view it will be the box to the left of the view 
name. 

 

• In the dialog box set the display style back to Wireframe 
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• Under View Properties Select 
1. Display Cut and Fill Graphics 
2. Display Cut and Fill Values 

 
 

• This will display filled shaped on the cross section view, red for fill and green for 
cut. 
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• It will also display the Area for each shape and the Volume. The volume 
computed is the Average End Area method using the current section and the 
previous section. 

 
 

• By using the navigator and reviewing the sections for a corridor the designer can 
easily see if a shape does not match the proposed or existing surface. 

• Note that this method only displays the volumes for the selected corridor. At this 
section the ditch should be included as UCE but it is not showing, there is no 
shape and the Cut Area is shown as 0.00. 
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• By restarting the Dynamic Section view and selecting the ditch corridor the 
designer can see the volumes have been computed correctly. 
 

 

• Any areas that include detailed modeling and separate corridors will have to be 
viewed separately. 
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• Another limitation of this method is that detailed areas that are modeled with 
surface templates are not corridors and cannot be reviewed. To see dynamic 
sections of an area that has been modeled with surface templates the Alignment 
must be selected as the base option. This will display an outline where the 3D 
volume has been created, it won’t be shaded and the Areas and Volumes will not 
be displayed but it can be reviewed for any possible errors. 
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3. Earthwork Check – Component Quantities 
A. Component Quantities can be reported out for any corridor but have some 

limitations. 

• The quantities are only reported for a single corridor at a time, if the project is 
composed of multiple corridors they will have to be reported individually. 

• The quantities are reported for the entire corridor, they cannot be broken at 
summary stations or for left and right volumes. 

• The quantities use the average end are method, this can cause significant issues 
at grade separation because the section before and after the bridge could be 
averaged together if the corridor has not been carefully constructed. 

• Component quantities cannot be used on areas that have been modeled with 
surface templates 

B. Component quantities also have some benefits 

• Not only does this tool report the earthwork but it will also report other 
quantities and surface areas 

• The tool can provide a quick estimate of earthwork volumes during design 
without the need for additional files or steps 
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C. Report the Component Quantities for a corridor 

• Under the OpenRoads Modeling workflow find the Home Tab and the Model 
Analysis and Reporting Section. 

 
 

• Under the Corridor Reports dropdown find the Component Quantities tool 
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• At the prompt select the corridor, the easiest way to pick the corridor is to left 
click on the slope stake line. 
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• This will generate a report of all the components from the corridor. Closed 
components will report a volume and other components will report a surface 
area. 

 
 

• Cut and Fill is always reported as a volume. It is critical to be aware of how 
component quantities work, Average End Areas, and what they are reporting, 
quantities from a single corridor. 
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4. Earthwork Check – End Area Volume Report 
A. This method matches the End Area Volume calculations that have been done in the 

past.  
B. This tool must be used in a file that has the following elements either in the Active 

File or attached as a reference. 

• Existing Terrain Model 

• Earthwork Volume Shapes 

• Cross Section Named Boundaries 
C. The best file to use this tool is likely the file that contains the 3D Earthwork Volume 

Shapes 

• R-2635C_RDY_EAR_RPY18A.dgn 

• It’s not necessary to create a separate file because no elements are created with 
this tool 

• It could be done in the Cross Section Named boundary file but 3D Earthwork 
volumes should not be attached to the cross sections so that file would have to 
be attached and detached for each run. 

D. Open the earthwork shape file : R-2635C_RDY_EAR_RPY18A.dgn 
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E. At least one view should be the Default 3D view. That selection can be activated 
under the View Attributes drop down dialog in the top left corner of the view 
window. 
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F. The 3D view should have the 3D earthwork volumes in the Active file and the 
Existing terrain reference should be on. The display setting of the existing terrain do 
not matter. Any additional references can be off or on it does not matter. 
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G. Make the default view active by clicking in the window. In the reference dialog 
attach the Cross Section Named Boundary file 

• ….\R-2635C\Roadway\Sheets\R-2635C_RDY_XPL_RPY18A.dgn 

• It is not necessary to detach any additional reference files 

 
H. The cross section named boundaries now appear in the default 3D view, note that 

these do not have a default view associated with them and will not show in the 
default model unless the default 3D reference is on. 
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I. Switch to the OpenRoads Modeling workflow and the home Tab find the Model 
Analysis and Reporting Section. 
 

 
J. Under the Civil Analysis tool group find the End Area Volumes Report tool. 
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K. The dialog will prompt to select the named boundary group. Select the appropriate 
group, is only one set of cross section named boundaries is selected it will default to 
this group. Left click to confirm the selection. 

 
 

L. The next dialog box asks for a selection for the first named boundary for volume 
exception. This dialog is slightly misleading if not completely understood. This is 
asking for the first section to OMIT or Leave Out of the Volume Calculation. For 
Example, a Begin Bridge cross section. If a cross section is selected here the dialog 
will ask for the last cross section for the volume exception. This would be where to 
Start the End Area Volume calculation again, for example an end bridge cross 
section. If the user mistakenly selected the First and Last  cross section then no End 
Area Volumes would be reported. 
 
Reset to skip this dialog by right clicking in the window. 
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M. At this point the End Area Volume Report Window will be generated. This is a very 
familiar format that shows the Station, Cut and Fill Areas, and Cut and Fill Volumes. 
 

 
N. Pay close attention to the units, these are noted on the report in the middle just 

above the table. 
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O. Units can be changed without redoing the report. From the top left of the dialog 
window select Tools – Format Options. 

 
 

P. This will display all the available formatting options.  
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Q. On the Cubic Units line select the check box Convert to Cubic Yards 
 

 
R. The volume units are now displayed in cubic yards. 

 
 

S. This report can be saved in various format including Excel for additional review if 
desired. 
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5. Accuracy Review 
A. A comparison of the various methods reveals the accuracy expected during a review 

and verification of the Earthwork Volumes. All Volumes below are for RPY18A 
B. Cut Volume 

• Prismoidal = 1,204.06 CY 

• Component Quantities = 1,183.29 CY 
1. (-) 1.7% of Prismoidal 
2. Does not include the intersection areas modeled with surface templates 
3. Includes DDE from the ditch corridors 
4. Would be closer for models that only included corridors and no detailed 

modeling 

• End Area Volume Report = 1,339.23 CY 
1. (+) 11.2% of Prismoidal 
2. Does not account for irregular areas not displayed on cross section 
3. Accuracy could be improved by increasing cross section density 

C. Fill Volume 

• Prismoidal = 24,477.29 CY 

• Component Quantities = 20,470.03 CY 
1. (-) 16.4% of Prismoidal 
2. Does not include the intersection areas modeled with surface templates 
3. Would be closer for models that only included corridors and no detailed 

modeling 

• End Area Volume Report = 24,021.24 CY 
1. (-) 1.9% of Prismoidal 
2. Does not account for irregular areas not displayed on cross section 
3. Accuracy could be improved by increasing cross section density 

 
This shows that while the number cannot be verified directly and exactly that tools 
are available to determine with a reasonable amount of certainty that the Prismoidal 
volumes are correct as long as the designer understands the limitations and 
operation of the alternate methods. 
 
This also shows the learning to navigate the DGN files and review the earthwork 
shapes visually is a key skill when reviewing earthwork calculations and assuring 
accuracy. 
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Exercise 7 – Deliverable to NCDOT 
 
When submitting projects to NCDOT the following files and deliverables will be required for 
Earthwork Calculations and Documentation. 
 
 

1. Prismoidal Volumes 
A. This will be a CADD files(s) containing the 3D Prismoidal Volumes representing the 

Project Earthwork. The Prismoidal Volumes are the Earthwork Volumes that should 
be included in the plans and the quantities. 
 

2. Named Boundaries 
A. This will be a CADD File(s) containing the named boundaries used to separate the 

earthwork volumes. These boundaries will be developed in accordance with the Cost 
Based Estimate Qty Checklist and the NCDOT Roadway Design Manual. 
 

3. Quantity Report by Named Boundaries 
A. This will be a report file that documents the Earthwork quantities based on the 

Prismoidal Volumes. 
 

4. Earthwork Balance Card 
A. This is a spreadsheet that totals and documents the Project Earthwork Volumes. 

 
5. End Area Volume Report 

A. This is an OpenRoads Report created from the proposed cross sections. This report 
will be used by NCDOT to check and verify the Model and the Quantities match the  
plans and the cross sections. This report is not a replacement for the Prismoidal 
Volumes. 

 

The following documentation will show an example of each deliverable based on previously 

completed earthwork files. 
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Start by selecting the OpenRoads Designer 2023 Desktop Icon 
 

 
 
 
The WorkSpace is DOT_US North Carolina 
The WorkSet is R-2635C (Training) 
The Role is NCDOT_Roadway 
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1. Deliverable - Prismoidal Volumes 

A. The first deliverable consists of CADD file(s) that contain the 3d Prismoidal Volumes.  

B. For this example we will use 3 corridors 

• Y18 

• RPY18A 

• RPY18B 

C. The workflow for creating the Prismoidal Earthwork Volumes has been covered 

extensively in this module. The Volumes for Y18 and RPY18A have already been 

created. The following abbreviated steps will be used to create the Prismoidal 

Volumes for RPY18B. For more detailed steps review the previous sections in this 

training module. 

D. Create a new DGN File for the Earthwork Calculation 

• R-2635C_RDY_EAR_RPY18B.dgn 

• Use the 2D Seed File = Seed2D – English Design.dgn 

• Attach the Existing Terrain from the R-2635C_NCDOT_FS.dgn file and Set Active 

• Attach the Proposed Corridor R-2635C_RDY_CMD_RPY18B.dgn 
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E. Create the Prismoidal Volumes 

• On the Home Tab find the Model Analysis and Reporting Section 

• Under Civil Analysis find the Create Cut and Fill Volumes 

• Create the Cut and Fill Volumes and review the shapes for accuracy 

 

 

 

F. There are now 3 CADD files containing the Prismoidal Volumes. This is the first part 

of the required deliverables. 

• R-2635C_RDY_EAR_Y18.dgn 

• R-2635C_RDY_EAR_RPY18A.dgn 

• R-2635C_RDY_EAR_RPY18B.dgn 
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2. Deliverable – Named Boundaries 

A. The next part of the deliverables are the named boundaries. These are required to 

ensure that the Earthwork Breakdown meets NCDOT requirements. 

B. There are two sources of information for how to split the project earthwork. 

• The Cost Based Estimate Quantity Breakdown 

• This form is available on the NCDOT website under Contracts and resources 

• Section 1 Earthwork, includes a checklist documenting the required breakdown 

for the project earthwork volumes. 

 

 

• The other resource for how to split earthwork volumes is in the NCDOT Roadway 

Design Manual. 

1. For the May 2024 of the NCDOT RDM this information is in Section 15.4.1.1 

Earthwork Balance Sheet. 
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C. Place the named boundaries. 

• The named boundaries can be placed in the earthwork files or in separate files. 

For this example, we will place the named boundaries in the Earthwork Files. 

• The named boundaries for Y18 have already been placed in the earthwork file 

1. The File name is R-2635C_RDY_EAR_Y18.dgn 

2. The named boundaries were placed to split the earthwork at the grade 

separation based on NCDOT guidance. 

3. Review Exercise 2 for detailed steps on how to place these named 

boundaries. 
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• Add named boundaries for RPY18A 

1. All alignments/corridors will require a named boundary to generate the 

quantity report even if the earthwork is not broken into smaller sections 

2. Open R-2635C_RDY_EAR_RPY18A.dgn 

3. Select the Named Boundary Tool 

a. Using the Civil Plan option place a named boundary based on the RPY18A 

centerline. 

b. Adjust the Length and Offset as required to enclose the previously 

created earthwork volumes. 

c. Based on NCDOT requirements this corridor only requires 1 named 

boundary. 
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• Repeat this process for Y18RPB 

1. The Named Boundary should be placed in the R-

2635C_RDY_EAR_RPY18B.dgn CADD file. 

2. Attach the alignment file R-2635C_RDY_ALG_RPY18B.dgn 

3. Use the Named Boundary Tool to place the Named Boundary 

4. Based on NCDOT requirements and guidelines this Alignment/Corridor only 

requires 1 Named Boundary. 
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3. Deliverable – Quantity Reports 

A. The quantity reports based on the Plan View named boundaries are a deliverable 

and are the quantities that should be included in the plans and estimates. 

B. The quantities in these reports will match the Prismoidal Volumes and will be broken 

down into sections based on NCDOT Requirements. 

C. These quantities will be used to complete the Earthwork Balance Card. 

D. For detailed steps see previous exercises, this workflow was covered in multiple 

sections throughout the Training Module. 

E. Create the quantity reports for Y18 

• Open R-2635C_RDY_EAR_Y18.dgn 

• On the Home Tab in the Model Analysis and Reporting Section select the 

Quantities report By Named Boundary tool 

• Select the Earthwork Quantities.xsl Style Sheet 
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• This will display on the Cut and Fill Volumes 

 

 

• Save the Report as an HTML Document named EAR_Y18.html. This is the report 

that will be a deliverable to NCDOT 

• Note that the Baseline Station indicates the End Station of the Named Boundary 

not necessarily the Station where the project end or the earthwork break. In this 

example the Earthwork will be broken for the Bridge that Begins at 27+18 and 

Ends at 29+08. Because the earthwork shapes are only created based on the 

limits Roadway Model we don’t necessarily have to break the named boundaries 

at the Begin or End of the bridge. For more explanation see the Section on 

Named Boundaries. 

• For this example the Prismoidal Earthwork Volumes  

1. Y18 Sta 11+94 to 27+18 

a. Cut = 4,931 CY 

b. Fill = 28,827 CY 

2. Y18 Sta 29+08 to 40+64.91 

a. Cut = 5,158 CY 

b. Fill = 61,384 CY 

 

  



 

Module 15 – Earthwork 
 

 
 

Page | 232  
 
 

• Repeat this process for RPY18A and RPY18B 

1. RPY18A Sta 5+20.01 to 15+28.12 

a. Cut = 1,204 CY 

b. Fill = 24,477 CY 

2. RYY18B Sta 5+19.70 to 12+69.09 

a. Cut = 10,925 CY 

b. Fill = 19,377 CY 

• This completes the quantity reports and there should be 3 re 

• port files saved in HTML format. 

1. EAR_Y18.html 

2. EAR_RPY18A.html 

3. EAR_RPY18B.html  
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4. Deliverable – Earthwork Balance Card 

A. The Earthwork Balance Card is where the Raw Earthwork Volumes created from the 

Named Boundaries and Prismoidal Shapes are compiled and tabulated to determine 

the Contract Estimate Quantities. 

B. The Final Earthwork Balance Card will include Geotechnical Quantities and 

recommendations that will also affect the totals. 

C. For detailed instructions on how to complete an Earthwork Balance Card see Section 

15.4.1 in the NCDOT Roadway Design Manual – Revision May 2024. 

D. The completed Earthwork Balance Card for this project: 

• Ther are 2 sections separated by the proposed bridge. 
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• The excavation numbers have been totaled based on the Raw Cut Volumes 

 

• Embankment and Borrow Numbers have been calculated and totaled based on 

the Raw Fill volumes. 
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• These columns have been totaled at the bottom of the sheet. 

 

 

• There is also a check below the Balance Card that verifies the volumes add 

together correctly. 
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• This completed spreadsheet is a Deliverable to NCDOT. 
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5. Deliverable – End Area Volume Report 

A. The End Area Volume Report was detailed in Exercise 6. This is a tool that reports 

Earthwork using the Average End Area Volume method and is based on the cross 

section named boundaries. 

B. This report is only used as verification of the Prismoidal Volumes not as a 

replacement. Generating this report allows for the Cut and Fill Areas from the cross 

sections to be checked and verified and the volume total generated by Average End 

Area to be compared to the Prismoidal Volumes. It is only meant to identify large 

discrepancies. 

C. See the NCDOT Training Module for Sheeting for information on generating Cross 

Section Named Boundaries and DGN files. 

D. Open the Y18 Cros Section Named Boundary Layout File 

• This file is in the Roadway\Sheets directory 

• R-2635C-RDY_XPL_Y18.dgn 

• This is the same file used to create the cross section drawing and sheet models. 

It will already have the following files attached 

1. Existing Surface 

2. Proposed Alignment 

3. Proposed Corridor 

4. Any Detailed Modeling Areas 

• The named boundaries will already be created 
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E. Attach the Y18 Cut and Fill Volumes 

• R-2635C_RDY_EAR_Y18.dgn 

• These are required for the reporting 

• The program reads these shapes to determine the aeras at each named 

boundary. 

 

 

F. Create the End Area Volume report 

• The Default 3D view should be open. 

• Go to the Civil Analysis section in the Model Analysis and Reporting section on 

the Home tab 
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• Select the End Area Volumes Report Tool from the Civil Analysis tool group. 
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• Select the named boundary group from the drop down, for most projects there 

will only be a single group available. 
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• The next prompt asks for the Start Cross Section for Volume Exception. This is 

not the cross section at the beginning of the project this is the first cross section 

that will be left out, excluded, from the End Area report. For this example, we 

want the cross sections that cover the proposed bridge to be left out of the End 

Area report. Left click the named boundary at station 27+50 to start the 

exception, this is the first section on the proposed bridge. 
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• The next prompt is for the end section. This is the section that ends the 

exception and where the average end area calculations will start again. Select 

the section at 29+00, this is the last section on the bridge. 

 

 

Note that multiple sections can be defined at the same time and included in the 

same report if required. 
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• Right click to reset and complete the Exception Selection process. 

 

Note that the prompt offers the chance to select another starting section. 

 

• This will end the tool and bring up the report. It should automatically default to 

the EndAreaVolume.xsl style sheet. 
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• The report displays Stations, areas and volumes for each cross section named 

boundary. 

 

 

• Save this report in HTML format 

1. Name this report XS_EAVR_Y18.html 

• Notice that the named boundaries from 27+50 to 29+00 are included but the 

areas are listed as 0. 
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• Repeat this process for RPy18A and RPY18B. These 3 reports are part of the 

deliverables to NCDOT. 
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6. Comparing Prismoidal to Average End Area 

A. Now that we have completed the reports for each method we can compare the 

Prismoidal Volumes to the Average End Area Volumes. 

B. Note that the Average End Area method still uses the 3D volumes to determine the 

area at each named boundary 

C. Prismoidal Method 

• Y18 

1. Cut  = 10,089 CY 

2. Fill = 90,211 CY 

• Y18RPA 

1. Cut = 1,204 CY 

2. Fil = 24,477 CY 

• Y18RPB 

1. Cut = 10,925 CY 

2. Fill = 19,377 CY 

• Total 

1. Cut = 22,218 CY 

2. Fill = 134,065 CY 

D. Average End Areal Method 

• Y18 

1. Cut  = 10,100 CY 

2. Fill = 88,694 CY 

• Y18RPA 

1. Cut = 1,164 CY 

2. Fil = 21,877 CY 

• Y18RPB 

1. Cut = 9,248 CY 

2. Fill = 18,146 CY 

3.   

• Total 

1. Cut = 20,512 CY 

2. Fill = 128,717 CY 

E. The difference between the Prismoidal Area and the Average End Area Methods 

• Cut = 8% 

• Fill = 4% 
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F. Based on these numbers we can see that the Average End Area method is capable or 

producing an adequate check of the more accurate Prismoidal Volumes. 
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7. Final Deliverables 

A. The final deliverables to NCDOT from this example that included Earthwork from 

three alignments, Y18, RPY18A and RPY18B would be as follows. 

B. Prismoidal Volume CADD Files 

• R-2635C_RDY_EAR_Y18.dgn 

• R-2635C_RDY_EAR_RPY18A.dgn 

• R-2635C_RDY_EAR_RPY18B.dgn 

C. Named Boundary CADD Files 

• These could be in separate files for this example they are located in the 

Prismoidal Volume CADD files 

D. Quantity Reports by Named Boundary 

• EAR_Y18.html  

• EAR_RPY18A.html 

• EAR_RPY18B.html 

E. Earthwork Balance Card 

• R-2635C Balance Sheet – Earthwork.xlsx 

F. End Area Volume Reports 

• XS-EAVR_Y18.html  

• XS-EAVR_RPY18A.html  

• XS-EAVR_RPY18B.html  

 

 


